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1. Оценка напряженно-деформированного состояния 

ферменной конструкции 

Автор: Крючков А.Э. 

Организация: ООО ТЕСИС 

В данной работе рассматривается статически неопределимая 

конструкция, для которой находится поле перемещений и выполняется оценка 

напряженно-деформированного состояния. На рисунке 1.1 представлена 

принципиальная схема задачи. К точке 1 прилагается сила в 𝐹𝑦 =  −40 кН. 

Данная точка находится на расстоянии 3,05 м от узлов 2 и 4. Точка 3 

находится на расстоянии 3,05 м от точек 2 и 4, формируя квадрат. Точки 2, 3 и 

4 жестко закреплены. Балка 1 соединяет точки 1 и 2, балка 2 соединяет точки 

1 и 3, и балка 3 соединяет точки 1 и 4. Линейный статический анализ 

выполняется с использованием стержневых конечных элементов. Свойства 

материала указаны в таблице 1.1. 

 

Рисунок 1.1 – Постановка задачи 

Таблица 1 – Параметры материала 

Модуль Юнга, (Па) Коэффициент Пуассона Площадь сечения, (м
2
) 

2,07 10
11

 0,3 1,29 10
-3

 

 В работе выполнено сравнение численного и аналитического решений 

для перемещений узла 1. Получены напряжения в первой балке – 27 МПа; во 

второй:  – 10 МПа; и в третьей – 7 МПа [1].  
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Система координат модели и система единиц измерения 

Построение расчетной модели и обработка результатов производится в 

декартовой системе координат в международной системе единиц (СИ). 

Таблица 2 – Система единиц измерения 

Длинна Сила Масса Время Давление 

м Н г с Па 

Геометрическая модель 

Откроем в дереве модели модуль SKETCH. Для создания чертежа 

нажмите на кнопку Create Sketch , или дважды щелкните на значке 

 в дереве модели (Рисунок 2.1). 

 

Рисунок 2.1 – Создание эскиза модели 

В появившемся окне назовите чертеж truss_demo и нажмите Continue. В 

появившемся рабочем поле, воспользовавшись инструментом , создаем 

четыре точки с координатами (0,0), (3,05,0), (3,05, 3,05), (0, 3,05).  

После задания координат каждой точки, подтверждаем свой выбор 

клавишей Enter (или средней кнопкой мыши). Затем с помощью инструмента 

 соедините точку (0,0) с тремя другими точками (Рисунок 2.2). В случае 

ошибки можно произвести отмену действия при помощи кнопки Cancel. 

Выходим из режима Эскиз, нажав кнопку Done.   
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Рисунок 2.2 – Построение эскиза модели 

 Откроем в дереве модели модуль PART. Для создания детали нажмите 

кнопку Create Part  или дважды щелкните на значке  в дереве 

модели (рисунок 2.3). 

 

Рисунок 2.3 – Создание модели 

 В появившемся окне Create Part (Рисунок 2.3) примите следующие 

установки: 2D (двухмерного), Deformable (деформируемого) тела и Wire в 

качестве базового свойства. Щелкните Continue, чтобы закрыть диалоговое 

окно. Теперь можно добавить ранее созданный чертёж. Для этого нажмите на 

Add => Sketch и выберите чертёж модели truss_demo. Нажмите Done, чтобы 

подтвердить выбор. Выходим из режима Эскиз, нажав кнопку Done. 
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Модель материала 

Для создания материала, из которого изготовлена модель, воспользуемся 

либо элементом меню Material => Create, либо кнопкой Create Material  на 

текущей панели инструментов или дважды кликнув на  в дереве 

модели. В появившемся окне Edit Material в меню редактора выберем 

Mechanical => Elasticity => Elastic и введем значение модуля Юнга – 2,07 10
11

 

– и коэффициента Пуассона – 0.3 (Рисунок 2.4). 

 

Рисунок 2.4 – Определение модели материала 

 Для того чтобы определить сечение открываем диалоговой окно Create 

Section (вызов возможен либо из Дерева модели, либо через иконку ). В 

диалоговом окне Create Section оставим имя Section-1 по умолчанию. В 

соответствующих списках выберете Beam, Truss и нажмите Continue. В 

появившемся окне редактора сечений Edit Section, в качестве материала 

необходимо указать созданный ранее материал Material-1, и указать площадь 

сечения равное 1,29 10
-3 

м
2
 (Рисунок 2.5).  
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Рисунок 2.5 – Создание сечения 

Следующим шагом присвоим построенное сечение ранее созданной 

геометрии. Для этого используем иконку  Assign Section в текущей панели 

инструментов, дважды щелкаем по элементу в дереве модели, или через 

основное меню Assign => Section. С помощью мыши выделите 

геометрическую модель, она будет подсвечена красным цветом. Нажмите 

Done. В появившемся окне, выберите созданное сечение Section-1 и 

подтвердите выбор нажатием кнопки ОК. 

 

Рисунок 2.6 – Создание экземпляра сборки 

Сборка 

Перейдём к модулю ASSEMBLY. Для создания сборочной единицы 

необходимо нажать на иконку Create Part Instance  (либо в дереве модели 

дважды кликнуть по элементу  , либо воспользоваться командами: 
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меню Instance => Create). В нашем случае деталь всего одна, выберем ее в 

появившемся окне – она будет выделена красным цветом. В разделе Instance 

Type укажите Dependent и подтвердите выбор, нажав ОК (Рисунок 2.6). 

Определение процедуры анализа 

В Дереве Модели дважды щелкните по контейнеру Step. В окне Create 

Step примите название по умолчанию. Задаем расчет Static, General и 

щелкните Continue. В появившемся окне Edit Step, оставьте все настройки 

солвера без изменений и нажмите ОK (Рисунок 2.7). 

 

Рисунок 2.7 – Определение процедуры анализа 

Нагрузки и граничные условия 

Для задания нагрузки и граничных условий для конструкции перейдем в 

модуль LOAD. Для создания нагрузки необходимо нажать на иконку Create 

Load  (либо в дереве модели дважды кликнуть по элементу , либо 

воспользоваться командами: меню Load => Create). В появившемся окне 

Create Load задайте категорию Mechanical и тип Concentrated Step. Далее 

выберите узел в точке (0,0) и нажмите Done. Откроется окно Edit Load. 

Укажите силу нагрузки в поле CF2 равную -44482 Н (Рисунок 2.8). 
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Рисунок 2.8 – Определение нагрузки 

 Для задания граничных условий необходимо нажать на иконку Create 

Boundary Condition  (либо в дереве модели дважды кликнуть по элементу 

, либо воспользоваться командами: меню BC => Create). В открывшемся 

меню Create Boundary Condition выберите категорию Mechanical и тип 

Displacement/Rotation. Далее выберите точки, которые необходимо 

ограничить, по координатам (0, 3,05), (3,05, 3,05), (3,05,0). Нажимайте на 

точки левой кнопкой мыши, зажимая кнопку Shift, чтобы выбрать сразу 

несколько точек. Выбранные точки подсветятся красным цветом. После этого 

в окне Edit Boundary Condition отметьте галочкой перемещение по оси x и y – 

U1 и U2. Сделайте их равными нулю (Рисунок 2.9). 

 

Рисунок 2.9 – Определение граничных условий 
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Конечно-элементная модель 

Перейдем к модулю MESH. Выберите созданную ранее деталь Part-1 

(Рисунок 2.10). 

 

Рисунок 2.10 – Выбор детали в модуле MESH 

 Используйте кнопку Seed Edges  или команду меню Seed => Edges, 

чтобы задать размер конечного элемента. Выберите всю конструкцию и в 

появившемся окне Local Seeds выберите метод By Number и уменьшите число 

элементов до одного (Рисунок 2.11). Нажмите OK, а затем Done.  

 

Рисунок 2.11 

В окне Element Type (Mesh => Element Type) выберите следующий тип 

КЭ – T2D2 (Рисунок 2.12) или воспользуйтесь кнопкой Assign Element Type  

 и выберите всю деталь. В отрывшемся окне Element Type укажите Truss в 

разделе Family. Произведите разбиение – Mesh => Part. 
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Рисунок 2.12 – Выбор типа КЭ 

Запуск на расчет 

Перейдите в модуль JOB. С помощью иконки  Create Job (либо команд 

меню Job => Create, или дважды кликнув по элементу  в дереве модели) 

создайте задание на расчёт. В появившемся окне примите настройки по 

умолчанию.  

Для продолжения нажмите кнопку Continue. Задание на расчёт 

сформировано. Чтоб запустить расчёт, вызовите  Job Manager (либо 

раскройте элемент дерева модели, кликните правой кнопкой по 

заданию Job-1 и выберите Submit, либо командами меню Job => Manager). 

В появившемся окне Job Manager нажмите Submit. Надпись Running 

говорит о том, что расчет запустился. 
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Анализ полученных результатов 

На рисунке 3.1 представлены деформированная и недеформированная 

конструкции. Поле перемещений приведено на рисунке 3.2, а напряжений на 

рисунке 3.3. Перемещения узла 2 (рисунок 3.1) по оси X (переменная u) и по 

оси Y (переменная v). Напряжения в стержневых элементах приведено в 

таблице 4. 

 

Рисунок 3.1 – Деформированная конструкция (зелёный цвет) и 

недеформированная (черный). Масштабный фактор – 750. 

Таблица 3 – Сравнение результатов анализа 

 u v 

Аналитическое решение [1] 1,05 10
-4

 -4,02 10
-4

 

Abaqus 1,05 10
-4 

-4,03 10
-4 

 

 

Рисунок 3.2 – Перемещения по оси x 
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Таблица 4 – Напряжения в модели 

Номер балки Напряжения, МПа 

1 27 

2 10 

3 -7 
 

 

Рисунок 3.3 – Напряжение в конструкции 

Список использованных источников 
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2. Оценка напряженно-деформированного состояния 

пластины с отверстием. Задача Кирша. 

Автор: Крючков А.Э. 

Организация: ООО ТЕСИС 

В данном примере рассматривается алюминиевая пластина размером 

1,02 ∗ 10−1 м х 5,08 ∗ 10−2 х 2,54 ∗ 10−3 м с отверстием диаметром 2,54*10
-2

м, 

к ней приложено растягивающее напряжение равное 35 МПа. Численный 

эксперимент проводится для определения напряжений на грани отверстия. 

Задача решается в двумерной и в трехмерной постановке, а полученные 

результаты сравниваются между собой. На рисунке 1.1 представлена 

принципиальная схема задачи. Свойства материала приведены в таблице 1.1. 

 

Рисунок 1.1 – Схема детали 

Таблица 1.1 – Параметры материала 

Модуль Юнга, (Па) Коэффициент Пуассона 

2*10
11

 0,3 
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Система координат модели и система единиц измерения 

Построение расчетной модели и обработка результатов производится в 

декартовой системе координат. При моделировании принята следующая 

система измерений – международная система единиц (СИ). 

Таблица 2.1 – Система единиц измерения 

Длина Сила Масса Время Давление 

м Н г с Па 

Геометрическая модель 

В этом решение используется свойства симметрии данной модели, 

чтобы упростить решение задачи.  

Откроем в дереве модели модуль SKETCH. Для создания рисунка 

нажмите на кнопку Create Sketch , или дважды щелкните на значке 

 в дереве модели (Рисунок 2.1). 

 

Рисунок 2.1 – Создание эскиза модели 

В появившемся окне назовите рисунок и нажмите Continue. В 

появившемся рабочем поле, воспользовавшись инструментом  Create 

Isolated Point, создаем пять точек с координатами (0.0127, 0), (0.0254, 0), 

(0.0254, 0.0508), (0, 0.0508) и (0, 0.0127) (изображение рисунка можно 

подогнать под размер экрана с помощью кнопки  Auto-fit View). Затем с 

помощью инструмента  Create Lines: Connected соедините точки по 

часовой стрелке от (0, 0.0127) до (0.0127, 0). Теперь используйте инструмент 
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 Create Arc: Center and 2 Endpoints, чтобы соединить две оставшиеся 

точки аркой – центр находится в точке (0,0), затем соедините две оставшиеся 

точки. Финальный рисунок готов (Рисунок 2.2). В случае ошибки можно 

произвести отмену действия при помощи кнопки Cancel. Выходим из режима 

Эскиз, нажав кнопку Done. 

 

Рисунок 2.2 – Построение эскиза модели 

Откроем в дереве модели модуль PART. Для создания детали нажмите 

кнопку Create Part  или дважды щелкните на значке  в дереве 

модели (рисунок 2.3). 

 

Рисунок 2.3 – Создание модели 

В появившемся окне Create Part (Рисунок 2.3) примите следующие 

установки: 2D, Deformable и Shell в качестве базового свойства. Щелкните 
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Continue, чтобы закрыть диалоговое окно. Теперь можно добавить ранее 

созданный рисунок. Для этого нажмите на Add => Sketch и выберите рисунок. 

Нажмите Done, чтобы подтвердить выбор. Выходим из режима Эскиз, нажав 

кнопку Done. 

Теперь разделим деталь на три части, чтобы при построении сетки 

можно было увеличить точность расчета на нужных гранях. Используйте 

инструмент  Create Datum Point: Offset from Point, чтобы создать 

необходимую точку. Этот инструмент позволяет отметить точку на рисунке 

относительно другой выбранной точки. Точкой отсчета послужит середина 

правой грани. Выберите эту точку. Затем, введите координаты (-.0254,0,0) – на 

таком расстоянии будет находится созданная нами точка от уже 

существующей. Таким образом появится новая точка. Выберите инструмент 

 Create Partition => Face => Use shortest path between 2 points и выделите 

две ранее использовавшиеся точки. Затем, ипользуя тот же инструмент , 

выберите нижнюю часть детали и создайте разделение между серединной 

точкой правой грани и точкой посередине арки (Рисунок 2.4). 

 

Рисунок 2.4 – Разделение детали 
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Модель материала 

Создадим материал с необходимыми механическими свойствами. 

Создадим материал для детали. Для этого можно воспользоваться либо 

элементом меню Material => Create, либо кнопкой Create Material  на 

текущей панели инструментов или дважды кликнуть на  в дереве 

модели.  

В появившемся окне Edit Material в меню редактора выберем 

Mechanical => Elasticity => Elastic и введем значение модуля Юнга – 2*10
11

 – 

и коэффициента Пуассона – 0.3 (Рисунок 2.5). 

 

Рисунок 2.5 – Определение модели материала 

Перейдём к определению сечения. Открываем диалоговой окно Create 

Section (вызов возможен либо из Дерева модели, либо через иконку ).  

В диалоговом окне Create Section присвоим сечению имя Section-1 по 

умолчанию. Выберите в соответствующих списках Solid, Homogeneous и 

щелкните Continue (Рисунок 2.7). В появившемся окне редактора сечений Edit 

Section, в качестве материала необходимо указать созданный ранее материал 

Material-1. 
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Рисунок 2.6 – Определение сечения 

Следующим шагом присвоим построенное сечение ранее созданной 

пластине. Для этого используем иконку  Assign Section в текущей панели 

инструментов (либо дважды щелкаем по элементу в дереве модели, либо 

используем команды меню: Assign => Section). С помощью мыши выделите 

пластину, она будет подсвечена красным цветом. Нажмите Done. В 

появившемся окне, выберите созданное сечение Section-1 и подтвердите 

выбор нажатием кнопки ОК. 

Сборка 

Перейдём к модулю ASSEMBLY. Для создания сборочной единицы 

необходимо нажать на иконку Create Part Instance  (либо в дереве модели 

дважды кликнуть по элементу  , либо воспользоваться командами: 

меню Instance => Create). В нашем случае деталь всего одна, выберем ее в 

появившемся окне – она будет выделена красным цветом. В разделе Instance 

Type укажите Independent и подтвердите выбор, нажав ОК (Рисунок 2.8). 

 

Рисунок 2.7 – Создание экземпляра сборки 
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Определение процедуры анализа 

В Дереве Модели дважды щелкните по контейнеру Step. В окне Create 

Step примите название по умолчанию. Задаем расчет Static, General и 

щелкните Continue. В появившемся окне Edit Step, оставьте все настройки 

решателя без изменений и нажмите ОK (Рисунок 2.9). 

 

 

Рисунок 2.8 – Определение процедуры анализа 

Нагрузки и граничные условия 

Для задания нагрузки на и граничных условий для конструкции 

перейдем в модуль LOAD. Для создания нагрузки необходимо нажать на 

иконку Create Load  (либо в дереве модели дважды кликнуть по элементу 

, либо воспользоваться командами: меню Load => Create).  

В появившемся окне Create Load задайте категорию Mechanical и тип 

Pressure. Далее выберите верхнюю грань детали и нажмите Done. Откроется 

окно Edit Load. Укажите силу нагрузки в окошке Magnitude на -3,5e7 Па 

(Рисунок 2.8). 
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Рисунок 2.9 – Определение нагрузки 

Для задания граничных условий необходимо нажать на иконку Create 

Boundary Condition  (либо в дереве модели дважды кликнуть по элементу 

, либо воспользоваться командами: меню BC => Create). В открывшемся 

меню Create Boundary Condition выберите категорию Mechanical и тип 

Displacement/Rotation. Далее выберите нижнюю грань детали, а в 

появившемся окне Edit Boundary Condition укажите ограничение для 

перемещения по оси y, U2=0 (Рисунок 2.11). 

 

Рисунок 2.10 – Определение граничных условий 

 Далее таким же образом установите еще одно граничное условие. 

Выберите всю левую грань детали и укажите ограничение по оси x, U1=0. 
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Конечно-элементная модель 

Перейдем к модулю MESH. Перейдите в меню Mesh => Controls и 

выделите верхнюю часть детали. В появившемся окне Mesh Controls укажите 

форму Quad и технику Free (Рисунок 2.11). А для нижней части детали 

укажите технику Structured. 

 

Рисунок 2.11 – Настройка сетки 

 Перейдите в меню Mesh => Element Type и выберите всю деталь. 

Укажите Geometric Order – Quadratic и Family – Plane Stress (Рисунок 2.12). 

 

Рисунок 2.12 – Тип элемента сетки 
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 Используйте кнопку Seed Edges  или команду меню Seed => Edges. 

Выберите всю верхнюю часть детали и в появившемся окне Local Seeds 

выберите метод By Number и укажите 8 в окне количества элементов; Bias - 

None. Таким же образом выделите все внешние грани нижней части детали и 

укажите 10 в окне кол-ва элементов, но в этот раз поставьте Bias – Single и 

Bias Ratio = 1 (Рисунок 2.13). В настройках оставшейся диагональной грани 

укажите Bias Ratio =5. Произведите разбиение детали – Mesh => Part. 

 

Рисунок 2.13 

Запуск на расчет 

Перейдите в модуль JOB. С помощью иконки  Create Job (либо 

команд меню Job => Create, или дважды кликнув по элементу  в дереве 

модели) создайте задание на расчёт. В появившемся окне примите настройки 

по умолчанию.  

Для продолжения нажмите кнопку Continue. Задание на расчёт 

сформировано. Чтоб запустить расчёт, вызовите  Job Manager (либо 

раскройте элемент дерева модели, кликните правой кнопкой по 

заданию Job-1 и выберите Submit, либо командами меню Job => Manager).  

В появившемся окне Job Manager нажмите Submit. Надпись Running 

говорит о том, что расчет запустился.  
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АНАЛИЗ ПОЛУЧЕННЫХ РЕЗУЛЬТАТОВ 

На рисунках 3.1 и 3.2 представлены результаты анализа – поля главных 

напряжений. Масштабный фактор для всех рисунков равен 4000.  

2 D 3 D 

 
 

Рисунок 3.3 – Поле главных напряжений по оси ОХ 

 
 

Рисунок 3.4 – Поле главных напряжений по оси ОУ 

 Для того чтобы построить зависимость напряжений вдоль отверстия, 

необходимо зайти в меню Tools => Path => Create. Далее выберите тип Node 

List и назовите путь. Нажмите кнопку Add Before и последовательно 

выберите каждый узел как показано на рисунке 3.5. Нажмите Done после 

определения пути и кнопку OK в меню Edit Node List Path.  
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Рисунок 3.5 – Определение пути 

  Для построения графика функции на созданном Path перейдите в меню 

Tools => XY Data => Create и выберите источник Path в появившемся окне. 

Примите настройки по умолчанию и нажмите кнопку Plot. Для того, чтобы 

экспортировать данные перейдите в Plug-ins => Tools => Excel Utilities. В 

появившемся окне Excel Utilities выберите From Current XY Plot в разделе 

XY Data to plot in Excel. Завершите действие, нажав ОК. Данная процедура 

позволяет экспортировать данные из Abaqus и использовать их для 

дальнейшего анализа.  

 Полученная зависимость напряжения на отверстии от расстояния вдоль 

него, для рассмотренных в данном примере моделей, приведена на 

рисунке 3.6. Напряжения Sxx в точке 1 и Syy в точке 2 (см. рисунок 3.5) 

приведены в таблице 3.1. 

Таблица 3.1 – Значения главных напряжений 

 2D 3D 

Sxx (МПа)  -59,18 -59,46 

Syy (МПа)  153,31 154,02 

 

1 

2 
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Рисунок 3.6 – Зависимость напряжений вдоль отверстия. 
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3. Рост трещины под действием сжимающей 

нагрузки 

Автор: Маликов П.В. 

Организация: «Прогрестех» 

В рамках механики разрушения считается, что рост трещин происходит 

под действием растягивающих нагрузок, нормальных к плоскости трещины, 

или сдвиговых нагрузок. Сжимающие нагрузки в задаче о математическом 

разрезе в зависимости от своего направления либо не влияют на 

концентрацию напряжений в окрестности роста трещины, либо способствуют 

закрытию трещины, в случае, когда они направлены перпендикулярно линии 

разреза. Практические исследования, однако, показали возможность наличия 

и распространения трещин в материале, находящемся под действием 

трёхосного сжатия. Рост трещин при этом обычно происходит в направлении 

параллельном действию максимального сжимающего напряжения [1]. 

Наиболее характерны данные процессы для горных пород, находящихся под 

действием значительного сжатия (горного давления). Необходимость 

исследования данного феномена возникла в связи с проведением различных 

работ, связанных со строительством шахт, а также прокладкой тоннелей в 

горных породах, склонных к хрупкому разрушению. 

Математическая модель данного явления была построена в работах [2–4]. 

Упрощённая схема данного явления показана на Рисунке 1.1. Образование и 

рост трещины происходят на концах трещины PP', расположенной под углом 

к главным сжимающим напряжениям. Под действием наибольшего 

сжимающего напряжения 𝜎1 > 𝜎2 края трещины PP' скользят друг 

относительно друга, в результате чего происходит раскрытие «крыльев» PQ и 

P'Q' расположенных на концах трещины PP'. Таким образом, трещина PQ 

находится под действием нагрузки, нормальной к её поверхности. Действие 

сжимающего напряжения 𝜎2 способствует остановке роста трещины. В 
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приведённом в работе [2] решении коэффициенты интенсивности напряжений 

𝐾𝐼 и 𝐾𝐼𝐼 в окрестности кончика трещин Q вычисляются как сумма влияния 

сдвига трещины PP' напряжения приложенного на удалении от трещины. 

Точное решение контактной задачи при этом не проводится. 

 

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..1 - Рост трещины под действием сжимающих напряжений 

В рамках данной работы проведено построение конечно-элементной 

модели в пакете Abaqus для проверки приближённого решения аналитической 

задачи вычисления коэффициентов интенсивности напряжений в работе [2] и 

решения данной задачи с при численном моделировании контакта на берегах 

разреза PP'. В силу центральной симметрии геометрии и нагрузок 

относительно середины трещины PP' (точка O на рисунке 1.2) возможно 

получить решение, рассмотрев лишь половину конструкции, что особенно 

важно в свете достаточно жёстких ограничений на количество используемых 

элементов в студенческой версии Abaqus – 1000 узлов. Условие центральной 

симметрии можно смоделировать наложением условия симметрии 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 

 

30 
 

перемещений отрезков OA и OB относительно точки O. Для того чтобы 

исключить поворот модель как твёрдого тела относительно центра симметрии 

необходимо закрепить перемещение ещё одной точки модели. В качестве 

такой точки можно выбрать точку E – середину отрезка CD, закрепив её 

перемещения по горизонтали. В силу удалённости точки E от разреза, это не 

должно оказать серьёзного влияния на распределение напряжений в 

окрестности точки Q. 

 

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..2 - Постановка задачи 

Рассматривается два типа нагрузок. Для сравнения результатов расчёта с 

приближённым аналитическим решением поверхность разреза OP 

нагружается сдвиговым напряжением 𝜏, вычисленным по соотношениям, 

приведённым в работе [2] для ∠𝑃𝑂𝐵 = 30∘, вертикального расположения 

трещины PQ и 𝑙/𝑐 = 1. При моделировании сжатия трещины, к верхнему 

ребру модели (CD) прикладывается равномерно распределённая нагрузка 𝜎 

для различных углов наклона разреза OP. Задача решается для условий 

плоского напряжённого состояния. Материал является линейно упругим. Так 
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как интерес представляет распределение напряжений, а модель нагружается 

посредством приложения распределённой нагрузки, конкретное значение 

параметров материала с теоретической точки зрения роли не играет. 

Система координат модели и система единиц измерения 

При создании модели и проведении расчёта используется декартова 

система координат и система единиц СИ. 

Таблица Ошибка! Текст указанного стиля в документе 

отсутствует..1 - Система единиц модели 

Длина Напряжения 

м Па 

Геометрическая модель 

Определение геометрии детали состоит из двух основных этапов – 

задания внешней границы детали и создания разбиения детали для 

дальнейшего создания разреза и конечно-элементной сетки в окрестности 

вершины трещины для снятия коэффициентов интенсивности напряжений.  

При создании детали в диалоге Create Part необходимо выбрать 

следующие свойства: 2D Planar (плоская двухмерная), Deformable 

(деформируемая) и Shell (пластина). Последний параметр означает, что 

создание детали начнётся с построения чертежа плоской грани, в противовес 

ребру (возможно, изогнутому) или точке при выборе альтернативных опций 

(Wire и Point соответственно). Параметр Approximate size задаёт размер сетки 

для построения первоначальной геометрии и может быть задан произвольно. 

Наиболее удобным значением данного параметра будет величина, равная 

нескольким характерным линейным размерам детали (или сечения для 

объемных деталей). В нашем случае вполне достаточно выбрать 10. 
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Внешняя граница детали имеет форму квадрата 2 × 2. В модуле Sketch 

его можно создать с помощью инструмента , задав прямоугольник с 

вершинами (-1, 0) и (1, 2). 

  

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..3 - Задание внешней границы детали 

После задания границы детали необходимо создать дополнительное 

разбиение детали, чтобы обозначить разрез а так же вспомогательные 

разбиения для построение конечно-элементной сетки. Учитывая 

относительную сложность разбиения, удобнее всего нарисовать его, 

воспользовавшись инструментом Tools→Partition→Face→Sketch или . 

Единственная доступная на текущей момент грань будет выбрана 

автоматически. Построение эскиза разбиения удобно начать с создания 

вспомогательной геометрии. Для этого в середине нижнего ребра нужно 

поставить точку (инструмент ) и провести через неё две вспомогательные 

линии (construction lines, ) – вертикальную и наклонную (под 

произвольным углом). После этого двумя отрезками (инструмент ) нужно 
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задать контур будущего разреза, построив наклонный отрезок на 

вспомогательной лини, а отрезок, соответствующий линии PQ в постановке 

задачи сделав вертикальным. Кроме того, для построения сетки конечных 

элементов потребуются дополнительные разбиения детали. Для их создания 

нужно построить три окружности (инструмент ) с центром в вершине 

разреза. При задании окружности необходимо помнить, что точка на 

окружности, отмечаемая при её построении является граничной точки 

получаемого в результате ребра и учитывается при построении конечно-

элементной сетки, что может затруднить ручное создание узлов конечных 

элементов и ограничить выбор доступных техник разбиения. Чтобы избежать 

этого, достаточно при построении окружностей в качестве второй точки 

выбирать точку, лежащую на линии разреза. Построение геометрии разбиения 

завершает разбиение построенных окружностей горизонтальным и 

вертикальным отрезками, проходящими через их центр. После этого 

необходимо более строго задать размер разреза и радиусы окружностей. Так 

как моделируется случай 𝑙/𝑐 = 1, на отрезки, задающие границу разреза 

нужно наложить связь (инструмент ) equal length. Размеры элементов 

разбиения нужно задать инструментом , как показано на рисунке 2.3. 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..4 - Построение разбиения детали 

Середина верхнего ребра модели будет использоваться для наложения 

граничных условий, следовательно, его нужно разбить пополам. Сделать это 

можно при помощи команд Tools→Partition→Edge→Enter parameter или 

инструмента , выбрав параметр 0.5. 

  

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..5 - Построение разбиения детали и задание его размеров 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..6 - Разбиение верхнего ребра модели 

Модель материала 

С точки зрения теории коэффициенты концентрации напряжений для 

изотропного линейно-упругого материала зависит только от геометрии 

разреза и приложенных нагрузок, поэтому значения упругих модулей можно 

выбрать достаточно произвольно. В численном решении модули упругости 

повлияют на перемещения узлов модели. Большие значения перемещений 

узлов могут повлиять на моделирование контактного взаимодействия между 

краями разреза, переведя малое проскальзывание в конечное, и в критическом 

случае могут вызвать чрезмерную деформацию элементов, что негативно 

скажется на сходимости и точности результатов анализа. В силу этих причин 

для данной задачи лучше выбрать материал с большим значением модуля 

Юнга. 

Для создания материала в модуле Property нужно выбрать пункт меню 

Material→Create… или инструмент . В появившемся диалоге нужно 

задать свойства линейной упругости материала 

(Mechanical→Elasticity→Elastic) и задать значения модуля Юнга и 

коэффициента Пуассона, как 1e10 и 0.33 соответственно. Введённое значение 

коэффициента Пуассона является типичным для многих металлов и сплавов. 
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Кроме того, для задания свойств детали необходимо создать сечение. Это 

можно сделать с помощью меню Section→Create… или инструмента . Так 

как рассматриваемая модель находится в условиях плоского напряженного 

состояния, необходимо создать однородное (Solid, Homogeneous) сечение. 

Созданное сечение необходимо присвоить созданной ранее детали, 

выбрав пункт меню Assign → Section или инструмент . 

 

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..7 - Задание свойств материала и сечения 

Сетка конечных элементов 

При создании сетки конечных элементов необходимо руководствоваться 

следующими соображениями: 

- Сетка должна быть достаточно мелкой в окрестности разреза; 

- Плотность сетки может быть уменьшена на удалении от выреза (на 

внешней границе детали); 
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- Условия центральной симметрии на нижнем ребре детали будет 

удобнее моделировать, если узлы сетки также будут симметричны 

относительно середины ребра; 

- Для того чтобы стало возможно вычисление коэффициентов 

интенсивности напряжений в окрестности вершины разреза, конечные 

элементы в этой области должны быть четырёхугольными. 

Создание сетки необходимо начать с задания разбиения рёбер детали и техник 

построения сетки для отдельных областей модели либо для модели целиком. 

Для задания разбиения всех рёбер необходимо в модуле Mesh ранее созданной 

детали выбрать пункт меню Seed→Part… (или инструмент ) и задать 0.2 в 

качестве размера ребра элемента. Теперь нужно задать особые условия 

разбиения отдельных рёбер модели. Это можно сделать, выбрав пункт меню 

Seed→Edges… (или инструмент ). Для обоих нижних рёбер детали нужно 

задать разбиение на 15 элементов (выбрав By number  в качестве метода 

определения) и запретить отступление от заданного разбиения, выбрав пункт 

Do not allow the number of elements to change на вкладке Constraints диалога 

Local Seeds, чтобы иметь более чёткий контроль над построением сетки. 

Аналогично для рёбер разреза нужно задать разбиение на 10 элементов, для 

дуг окружностей – на 4, и для радиальных рёбер – на 2. 

Для построения сетки в окрестности вершины разреза, нужно задать технику 

разбиения модели отличную, от выставленной по умолчанию. Выбрав пункт 

меню Mesh→Controls… (инструмент ) нужно выбрать форму элементов 

Quad для областей, лежащих внутри кругов, построенных вокруг вершины 

выреза, для того чтобы исключить возможность генерации треугольных 

элементов, и технику Sweep для колец, окружающих вершины разреза. Выбор 

техник построения стеки конечных элементов и разбиение рёбер детали 

показаны на рисунке 2.6. 
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Тип элементов можно выбрать при помощи инструмента  (пункт меню 

Mesh→Element Type…). Нам потребуется выбрать plane stress элементы. 

Таким образом, будут использоваться элементы CPS4R в качестве 

четырёхугольных и CPS3 в качестве треугольных. 

Осталось только построить сетку, выбрав пункт меню Mesh→Part… или 

инструмент . 

 

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..8 - Задание разбиения рёбер и техник построения сетки 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..9 - Выбор типа элементов и сетка конечных элементов 

Сборка и создание разреза 

Для добавления созданной детали в пространство пространство анализа 

необходимо в модуле Assembly выбрать пункт меню Instance→Create… 

(инструмент ) и добавить единственную доступную деталь. 

На данном этапе деталь представляет собой квадрат с нарисованным на 

нём разбиением и сеткой конечных элементов, но без каких-либо разрезов. 

Добавить разрез можно, создав дополнительные узлы на его границе и 

переопределив элементы сетки. Это потребует модификации сетки конечных 

элементов, провести которую можно только на независимом экземпляре 

детали. Для того, чтобы сделать экземпляр детали независимым нужно в 

дереве Assembly в пункте Instance выделив правой клавишей мыши ранее 

созданный экземпляр, выбрать пункт Make Independent. Для создания 

разреза нужно перейти в модуль Interaction и, выбрав пункт меню 

Special→Crack→Assign Seam…, выделить границу разреза. Создание разреза 

изменит сетку конечных элементов, создав свободную поверхность/ребро на 

выделенной поверхности/ребре. Стоит отметить, что созданный разрез не 
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появится в дереве модели и будет отображаться только при 

создании/удалении разрезов. 

Для вычисления коэффициентов интенсивности напряжений необходимо 

дополнительно задать трещину. Это можно сделать в пункте меню 

Special→Crack→Create…, выбрав тип Contour Integral. После этого 

необходимо указать вершину разреза (одну точку) и задать направление роста 

трещины, выбрав либо нормаль к линии разреза, либо направление роста 

разреза (q vector). Так как разрез расположен вертикально, нормаль можно 

задать, указав две точки: (0, 0) и (1, 0). Созданное определение трещины будет 

использовано только для вычисления коэффициентов интенсивности 

напряжений и, в отличие от разреза, само по себе не окажет влияния на 

напряжённо-деформированное состояние. Трещина будет доступна в 

менеджере трещин (Special→Crack→Manager…).  

 

 

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..10 - Определение границы разреза и задание трещины 

Контактные взаимодействия 
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В исследуемой модели потребуется задать только один контакт – между 

границами наклонной части разреза. Это верно в предположении, что 

горизонтальная сжимающая нагрузка отсутствует либо недостаточна того, 

чтобы границы вертикального участка трещины начали вдавливаться друг в 

друга. 

Для задания свойств контактного взаимодействия в модуле Interaction 

нужно выбрать пункт меню Interaction→Property→Create… (инструмент 

) и тип свойства contact. Для наших целей достаточно задать нормальное и 

касательное поведение касающихся поверхностей (Mechanical→Normal 

Behavior и Mechanical→Tangential Behavior соответственно). При 

определении нормального взаимодействия достаточно оставить условия по 

умолчанию и снять галочку с пункта Allow separation after contact, так как 

поверхности в рассматриваемой задаче находятся в контакте на протяжении 

всего времени анализа. Касательное взаимодействие необходимо задать для 

расчёта задач, учитывающих трение. Учитывая малый размер модели, для 

задания касательного взаимодействия можно использовать метод Lagrange 

Multiplier обеспечивающий более высокую точность по сравнению с 

другими. 

Для задания контакта между поверхностями необходимо задать 

контактные поверхности. В нашем случае особенностью определения 

контактных поверхностей является то, что они лежат на поверхности разреза и 

не ассоциированы с какой-либо внешней границей детали, поэтому их 

придётся задавать как границу конечных элементов. Перед определением 

контактной поверхности удобно скрыть с экрана часть элементов границы 

разреза, которые не будут в неё входить. Для этого в модуле Assembly нужно 

включить отображение сетки (инструмент ) и включив в панели 

инструментов выделение элементов ( ) выделить элементы 

одной из границ разреза и скрыть их ( ). Теперь можно создать 
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поверхность, дважды щелкнув по пункту Surfaces в дереве сборки (или 

воспользовавшись пунктом меню Tools→Surface→Create…), выбрав Mesh в 

качестве типа поверхности и выделив рёбра элементов, лежащие на 

оставленной границе разреза. Вернуть скрытые элементы можно, нажав . 

Аналогично нужно выбрать другую границу разреза. 

Для задания контакта между созданными поверхностями в модуле 

Interaction нужно выбрать пункт меню Interaction→Create (инструмент ) и 

тип Surface-to-surface contact. В качестве контактных поверхностей нужно 

указать две ранее созданные поверхности, а в качестве свойств контакта – 

созданные ранее свойства. В качестве формулировки контакта стоит выбрать 

Small sliding, так как задача не предполагает значительного (порядка ребра 

элемента) проскальзывания поверхностей друг относительно друга. 

Дополнительно можно установить свойство Adjust only to remove 

overclosures, но это не критично, так как поверхности изначально точно 

касаются друг друга. 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..11 - Свойства контактного взаимодействия 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..12 - Выбор контактной поверхности 

 

 

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..13 - Определение контакта между поверхностями 

Нагрузки и граничные условия 
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Перед созданием нагрузок необходимо определить шаг анализа. Для этого 

в модуле Step нужно выбрать пункт Step→Create… (инструмент ) и тип 

шага Static, General. Дополнительные параметры можно оставить без 

изменения, так как исследуется линейная задача. 

Как было указано в постановке задачи, граничные условия состоят из двух 

основных элементов – условий центральной симметрии на нижнем ребре 

модели и закрепления горизонтальных перемещений середины верхнего ребра 

(точка E на рисунке 1.2). Abaqus позволяет задать условие циклической 

симметрии при помощи взаимодействия cyclic symmetry (модуль Interaction). 

Недостатком этого способа является то, что связываемые поверхности не 

должны пересекать ось или центр симметрии, а в нашем случае края разреза 

лежат в центре симметрии. Альтернативой данному подходу является задание 

связи между точками методом equation. Связь equation можно задать как в 

CAE так непосредственно в input файле. Недостатком задания такой связи 

через CAE является необходимость создания наборов точек (Node set), в то 

время как синтаксис input файла позволяет обращаться к связываемым точкам 

непосредственно по номеру. Нам нужно связать уравнениями перемещения 

узлов, симметричных относительно середины нижнего ребра так, чтобы 

сумма перемещений по оси 𝑥 и сумма перемещений по оси 𝑦 были равны 

нулю. Для этого необходимо узнать номера узлов нижнего ребра при помощи 

инструмента  (пункт меню Tools→Query) и запроса информации об узлах 

(Point/Node). Так же можно включить отображение номеров узлов (View→ 

Assembly Display Options→Mesh→Show node labels→OK) Далее 

необходимо добавить ключевые слова, задающие уравнения в input файл. Это 

можно сделать, выбрав пункт меню Model→Edit Keywords и добавив на 

уровень Assembly строчки вида 

*Equation 

2 

Part-1-1.16,1,1,Part-1-1. 590,1,1 
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для каждой пары связываемых узлов для первой и 

*Equation 

2 

Part-1-1.16,2,1,Part-1-1. 590,2,1 

для второй степеней свободы узла. Первый и четвёртый аргументы в третьей 

строчке – имена экземпляра детали и номера узлов, второй и пятый – номера 

степеней свободы, третий и шестой – коэффициенты при указанных 

переменных в линейном уравнении. 

 

Рисунок Ошибка! Текст указанного стиля в документе отсутствует..14 (a) 

– Отображение номеров узлов для узлов нижней поверхности 

Для узлов модели, приведенных на рисунке 2.12 (а) необходимо 

добавить следующие строчки: 
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*Equation 

2 

Part-1-1.16,1,1,Part-1-1.590,1,1 

*Equation 

2 

Part-1-1.80,1,1,Part-1-1.108,1,1 

*Equation 

2 

Part-1-1.79,1,1,Part-1-1.109,1,1 

*Equation 

2 

Part-1-1.78,1,1,Part-1-1.110,1,1 

*Equation 

2 

Part-1-1.77,1,1,Part-1-1.111,1,1 

*Equation 

2 

Part-1-1.76,1,1,Part-1-1.112,1,1 

*Equation 

2 

Part-1-1.75,1,1,Part-1-1.113,1,1 

*Equation 

2 

Part-1-1.74,1,1,Part-1-1.114,1,1 

*Equation 

2 

Part-1-1.73,1,1,Part-1-1.115,1,1 

*Equation 

2 

Part-1-1.72,1,1,Part-1-1.116,1,1 

*Equation 

2 

Part-1-1.71,1,1,Part-1-1.117,1,1 

*Equation 

2 

Part-1-1.70,1,1,Part-1-1.118,1,1 

*Equation 

2 

Part-1-1.69,1,1,Part-1-1.119,1,1 

*Equation 

2 

Part-1-1.68,1,1,Part-1-1.120,1,1 

*Equation 

2 

Part-1-1.67,1,1,Part-1-1.121,1,1 

*Equation 

2 

Part-1-1.15,1,1,Part-1-1.20,1,1 

*Equation 

2 

Part-1-1.16,2,1,Part-1-1.590,2,1 

*Equation 

2 

Part-1-1.80,2,1,Part-1-1.108,2,1 

*Equation 

2 

Part-1-1.79,2,1,Part-1-1.109,2,1 

*Equation 

2 

Part-1-1.78,2,1,Part-1-1.110,2,1 

*Equation 

2 

Part-1-1.77,2,1,Part-1-1.111,2,1 

*Equation 

2 

Part-1-1.76,2,1,Part-1-1.112,2,1 

*Equation 

2 

Part-1-1.75,2,1,Part-1-1.113,2,1 

*Equation 

2 

Part-1-1.74,2,1,Part-1-1.114,2,1 

*Equation 

2 

Part-1-1.73,2,1,Part-1-1.115,2,1 

*Equation 

2 

Part-1-1.72,2,1,Part-1-1.116,2,1 

*Equation 

2 

Part-1-1.71,2,1,Part-1-1.117,2,1 

*Equation 

2 

Part-1-1.70,2,1,Part-1-1.118,2,1 

*Equation 

2 

Part-1-1.69,2,1,Part-1-1.119,2,1 

*Equation 

2 

Part-1-1.68,2,1,Part-1-1.120,2,1 

*Equation 

2 

Part-1-1.67,2,1,Part-1-1.121,2,1 

*Equation 

2 

Part-1-1.15,2,1,Part-1-1.20,2,1 

Центральный узел верхнего ребра модели можно закрепить, выбрав в 

модуле Load пункт меню BC→Create… (инструмент ), тип 

Displacement/Rotation и запретив перемещения по оси 𝑥 (U1). 

Расчёт будет проводиться для вертикальной сжимающей нагрузки 𝜎 = 1000 

(рисунок 1.2). Как было указано в постановке задачи, расчёт будет проведён для 
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двух типов нагрузки – для давления 𝜎, приложенного к верхнему ребру модели и 

для сдвиговой нагрузки 𝜏, приложенной к верхней границе наклонного выреза. 

Давление 𝜎 может быть приложено в модуле Load в первом шаге анализа путём 

выбора пункта меню Load→Create… (инструмента ) и типа нагрузки Pressure. 

В качестве области приложения нагрузки следует выбрать верхнее ребро модели, 

а величину нагрузки сделать равной 1000. 

Согласно приближённому решению, представленному в работе [2], при 

приложении только сжимающего давления, на поверхность разреза действует 

усилие 𝜏 =
1

2
𝜎 sin 2𝛾 (𝛾 – угол между наклонным разрезом и вертикальной осью). 

Для нашей нагрузки 𝜏 ≈ 433.013. Для того, чтобы приложить сдвиговую нагрузку 

нужно выбрать Surface traction в качестве типа нагрузки, выбрать созданную 

ранее контактную поверхность на верхней границе выреза, вектор, параллельный 

разрезу (по двум точка на разрезе) и величину 433.013. 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..15 (б) - Добавление уравнений при помощи инструмента Edit 

keywords 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..16 - Добавление нагрузок и граничных условий 

Запуск на расчет 

Перед запуском модели на расчёт необходимо создать запрос на вывод 

коэффициентов напряжений. Для этого в модуле Step нужно выбрать пункт меню 

Output→History Output Request→Create… (инструмент ) и запросит вывод 

коэффициентов интенсивности напряжений для ранее созданной трещины Crack-1 

(рисунок 2.14). Учитывая зависимость расчета J-интеграла используемого при 

вычислении коэффициент интенсивности напряжений от области вокруг вершины 

выреза, необходимо задать вывод коэффициента интенсивности для нескольких 

контуров. 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..17 - Запрос вывода коэффициента интенсивности напряжений 

После этого можно создать и запустить расчёт, выбрав пункт меню 

Job→Create… (инструмент ) в модуле Job со стандартными настройками. 

Анализ полученных результатовЦель работы состояла в исследовании 

зависимости свойств контактного взаимодействия на значение коэффициента 

интенсивности напряжений и сравнении результатов расчёта с приближённым 

аналитическим решением, полученным в работе [2]. Для исследования был 

выбран случай 𝑙/𝑐 = 1, и 𝛾 = 𝜃 (рисунок 1.1). Предложенное аналитическое 

решение не учитывает всех особенностей контактного взаимодействия на границе 

наклонного разреза, вычисляя коэффициент интенсивности напряжений как 

сумму коэффициентов, вызванных действием сдвига наклонного выреза и 

действием напряжений, приложенных на удалении, на вертикальный вырез. В 

случае одноосного сжатия и вертикального расположения трещины (𝛾 = 𝜃), 

влияние напряжений, приложенных на удалении от разреза на коэффициент 

интенсивности напряжений отсутствует, и коэффициенты интенсивности 

напряжений могут быть вычислены по формулам: 
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𝐾𝐼 =
2𝑐𝜏 sin 𝜃

√𝜋𝑙
,  𝐾𝐼𝐼 = −

2𝑐𝜏 cos 𝜃

√𝜋𝑙
, 

где 𝜏 – напряжение, вызывающее сдвиг поверхностей наклонной части разреза 

друг относительно друга. В случае одноосного сжатия, оно может быть найдено 

по формуле 

𝜏 =
1

2
𝜎 sin 2𝛾. 

Сравнение с этим решением было проведено при помощи модели с 

касательной нагрузкой, приложенной к поверхности наклонного выреза, и углом 

𝛾 = 60∘. Сжимающее напряжение в этой модели не прикладывалось, так как в 

теоретическом решении его влияние для случая 𝛾 = 𝜃 при одноосном сжатии 

сводится только к сдвигу границ наклонного разреза, что уже учтено 

приложением сдвиговой нагрузки. Трение на поверхности контакта отсутствует. 

Касательная нагрузка на поверхности контакта вычислена для значения 𝜎 = 1000. 

Построение данной модели описано в разделе 2. Результаты сравнения 

аналитического приближения и конечно-элементного решения приведены в 

таблице 3.1. Приведённые результаты сравнения показывают хорошее 

соответствие между теоретической и конечно-элементной моделью, с учётом 

достаточно грубой сетки и приближенного характера приведённого 

аналитического решения. 

Таблица Ошибка! Текст указанного стиля в документе отсутствует..2 – 

Сравнение аналитического решения и конечно-элементной модели 

 
Аналитическое значение, Па ⋅ √м Abaqus, Па ⋅ √м Ошибка, % 

KI 283.85 280.71 -1.12 

KII -163.88 -150.97 -8.55 

Для анализа влияния условий контакта коэффициент интенсивности 

напряжений был поострен ряд моделей для углов 𝛾 = 𝜃 от 10∘ до 80∘ с шагом 10∘ 

и трением на поверхности контакта, определяемым коэффициентом трения 𝜇 под 
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действием сжимающей нагрузки 𝜎 = 1000. Их построение аналогично описанию 

в разделе 2 с точностью до замены нескольких числовых параметров. Типичная 

картина распределения напряжений в построенных моделях показана на 

рисунке 3.1. На нём отчётливо видно, что вершина вертикального разреза 

находится под действием нормального отрыва (положительное напряжение 𝜎11). 

 

Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..18 – распределение напряжений в окрестности разреза 

(γ=70ᵒ, множитель перемещений 20) 

Зависимость коэффициента интенсивности напряжений от коэффициента 

трения и угла разреза приведена на рисунке 3.2. Коэффициент интенсивности 

уменьшается с увеличением коэффициента трения и стремится к нулю при 

стремлении угла 𝛾 к значениям 0∘ и 90∘. Стоит, однако, отметить что полученные 

значения коэффициента интенсивности выше приведённых в работе [2], что 

может быть объяснено более точным учётом модели контактного взаимодействия 

на границе наклонного разреза в конечно-элементном расчёте. 
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Рисунок Ошибка! Текст указанного стиля в документе 

отсутствует..19 – зависимость коэффициента интенсивности напряжений от 

коэффициента трения и угла разреза 
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4. Определение значения J-интеграла и коэффициента 

интенсивности напряжений для трещины отрыва 

Автор: Дияров К.А. 

Организация: УГНТУ, г. Уфа 

В рамках решения данной задачи производится нахождение значений 

J-интеграла и коэффициента интенсивности напряжений для трещины отрыва 

образца с плоским напряженным состоянием. Длина образца 40 мм, ширина 10 

мм, толщина 2 мм, длина трещины 2 мм. На рисунке 1.1 представлена 

принципиальная схема задачи. 

 

Рисунок 1.1 – Принципиальная схема задачи 

Граничные условия: 

1. Нижняя грань жестко закреплена. 

2. К верхней грани прикладывается усилие F=1000 Н. 
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Система координат модели и система единиц измерения 

Построение расчётной модели и обработка результатов производится в 

декартовой системе координат. 

При моделировании принята следующая система измерений – СИ (мм). 

Таблица 2.1 – Система единиц измерения 

Длина Сила Масса Время Напряжение Плотность 

мм Н т с МПа т\мм3 

Геометрическая модель 

Откроем в дереве модели модуль PART (рисунок 2.1). Для создания детали 

нажмите кнопку Create Part   , или дважды щёлкните на значке  в 

дереве модели. 

 

Рисунок 2.1 – Создание геометрической модели 

В появившемся окне Create Part (рисунок 2.2) дайте детали имя Plate и 

примите следующие установки: 2D (двухмерного), Deformable (деформируемого) 

тела и Shell (оболочка) в качестве базового свойства. В текстовом поле 

Approximate size наберите 100. Щелкните Continue, чтобы закрыть диалоговое 

окно. 

В появившемся рабочем поле (рисунок 2.3), воспользовавшись инструментом 

, создаём прямоугольник с координатами (0, 0) и (10, 40). После задания 
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координат каждой точки, подтверждаем свой выбор клавишей Enter (или средней 

кнопкой мыши). Далее нажимаем кнопку Done. 

  

Рисунок 2.2 – Создание новой детали Рисунок 2.3 – Построение эскиза модели 

Зададим геометрию трещины. Для этого воспользуемся инструментом  

Partition Sketch: Face .  В появившемся рабочем окне, щелкните по иконке  

Create Lines Connected  и постройте линию с координатами (-5, 0) и (-3, 0), 

далее нажмите на иконку и постройте окружность по координатам центра (-3, 

0) и точки на окружности (-2.5, 0) (рисунок 2.4).. Выйдите из инструмента, нажав 

среднюю кнопку мыши. Далее нажмите Done. 

Модель материала 

Перейдем в модуль PROPERTY. Зададим свойства материала. В Дереве 

Модели дважды кликните по контейнеру Materials, чтобы создать новый 

материал. В появившемся окне Edit Material (рисунок 2.5) присвойте материалу 

имя Steel, в выпадающем меню выберите Mechanical->Elasticity>Elastic и введите 

в соответствующих полях: 2E5 МПа для модуля Юнга и 0.3 для коэффициента 

Пуассона, далее нажмите ОК. 
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Рисунок 2.4 – Создание геометрии 

трещины 

Рисунок 2.5 – Определение свойств 

материала 

Теперь перейдём к определению свойств сечения. Нажимаем на инструмент 

Create Section . В диалоговом окне Create Section присвоим сечению имя Plate. 

Выберите в соответствующих списках Category: Solid, Type: Homogeneous и 

щелкните Continue. В появившемся диалоговом окне Edit Section,  в качестве 

материала необходимо указать Steel. Ставим галочку Plane stress/strain thickness, 

задаем значение толщины образца 2 мм(рисунок 2.6). Далее жмем ОК. 

Присвоим построенное сечение ранее созданной пластине. Для этого 

используем иконку  Assign Section в текущей панели инструментов, после 

выделим всю пластину, она будет подсвечена красным цветом. Нажмите Done. В 

появившемся диалоговом окне (рисунок 2.7), выберите сечение Plate и нажмите 

кнопку ОК. После выполнения данных операций, цвет модели станет зелёным. 
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Рисунок 2.6 – Определение свойств 

сечения 

Рисунок 2.7 – Присвоение сечения 

геометрической модели 

Сборка 

Перейдём в модуль ASSEMBLY. Для создания сборки нажмите на иконку 

Create Part Instance . В появившемся диалоговом окне (рисунок 2.8) в разделе 

Parts выберете Plate, а в  Instance Type укажите Independent и подтвердите выбор, 

нажав ОК. 

 

Рисунок 2.8 – Создание экземпляра сборки 
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Определение процедуры анализа 

Перейдём в модуль Step. Нажмите на панели инструментов иконку Create 

Step . В появившемся окне задайте имя нового шага анализа –  Static. Примите 

тип Static, General и щелкните Continue (рисунок 2.9). В появившемся окне Edit 

Step,  оставьте все настройки решателя без изменений и нажмите ОK. 

В появившемся окне Edit Step,  перейдите во вкладку Incrementation. В 

разделе Increment size измените значения Initial и Maximum на 0.25 (рисунок 2.7). 

Нажмите ОК. 

  

Рисунок 2.9 – Определение процедуры анализа 

Контактные взаимодействия 

Перейдите в модуль Interaction. Используя главное меню, откройте вкладку 

Special > Crack > Assign Seam, после чего при помощи клавиши Shift выделите 

заданный отрезок трещины (рисунок 2.12). Нажмите Done. 
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Аналогично, используя главное меню, откройте вкладку Special > Crack > 

Create. В появившемся окне (рисунок 2.13) выберите тип создаваемой трещины 

Contour integral и нажмите Continue. 

  

Рисунок 2.12 – Создание трещины 

         

Рисунок 2.13 – Определение типа трещины 

После чего выбираем фронт трещины, для этого нажимаем на точку в центре 

окружности, как показано на рисунок 2.14 и жмем Done.  

 

Рисунок 2.14 – Определение фронта трещины 
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Из предложенных вариантов определения направления трещины выберите q 

vectors (рисунок 2.15). Далее вводим начальные координаты вектора (-3, 0), 

нажимаем Enter и координаты направления (-2.5, 0).  

 

Рисунок 2.15 – Определение направления трещины 

После того как мы определили направление вектора, всплывает диалоговое 

окно Edit Crack. Как показано на рисунке 2.16 выбираем вкладку Singularity, в 

окне Midside node parameter вводим значение 0.25, выбираем тип Collapsed 

element side, single node и жмем ОК. 

  

Рисунок 2.16 – Параметры трещины 

Для добавления вывода значений J – интеграла в результаты анализа в дереве 

модели нажмите правой кнопкой на инструмент History output Requests , 

выберите Create. В окне Create History (рисунок 2.10)присвойте имя J и нажмите 

Continue. 

В появившемся окне Edit History output Requests (рисунок 2.11) выбираем в 

разделе Domain: Crack, количество контуров 5, Type: J-integral и нажимаем ОК. 
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Рисунок 2.10 – Создание вывода значений J – интеграла 

 

Рисунок 2.11 – Определение свойств вывода значений J – интеграла 

Аналогично, для вывода коэффициента интенсивности напряжений в области 

трещины в дереве модели нажмите правой кнопкой на инструмент History output 

Requests , выберите Create. В окне Create History присвойте имя SIF и 

нажмите Continue. 

В появившемся окне Edit History output Requests выберите в разделе Domain: 

Crack, количество контуров 5, Type: Stress intensity factors и нажимаем ОК. 
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Нагрузки и граничные условия 

Для того чтобы приложить силу ко всей грани, задайте опорную точку. Для 

этого, оставаясь в модуле Interaction, нажмите на иконку Create Reference Point 

и введите координаты (5, 45). Далее щелкните на инструмент Create Constraint 

, в появившемся окне (рисунок 2.17) выберите тип Coupling и нажмите 

Continue. Выберите опорную точку RP-1 в рабочем окне и нажмите Done, далее 

нажмите Surface и выберите верхнюю границу пластины. Нажмите Done. В 

появившемся окне Edit Constraint оставьте все без изменений и щелкните ОК. 

  

Рисунок 2.17 – Задание опорной точки 

Перейдём в модуль Load. На нижнюю грань пластины накладываются 

ограничения по перемещениям. Для моделирования данного граничного условия 

нажмите на иконку Create Boundary Condition . В появившемся окне (рисунок 

2.18) выберите Шаг: Initial, Тип: Symmetry/Antisymmetry/Encastre и нажмите 

Continue. 

Далее выберите нижнюю грань пластины и нажмите Done. В появившемся 

окне Edit Boundary Condition зафиксируйте все степени свободы, выбрав  

ENCASTRE (U1=U2=U3=UR1=UR2=UR3=0) и нажмите ОК. 
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Рисунок 2.18 – Задание ограничения 

Для моделирования нагрузки нажмите на иконку Create Load  . В окне 

Create Load (рисунок 2.19) укажите Шаг: Static, Тип: Concentrated force и 

нажмите Continue. 

 

Рисунок 2.19 – Выбор нагрузки 

Выберите опорную точку RP-1 в рабочем окне и нажмите Done. В окне Edit 

Load (рисунок 2.20) для CF2 укажите значение 1000 Н и нажмите ОК. 
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Рисунок 2.20 – Задание нагрузки 

Конечно-элементная модель 

Следующим шагом будет построение конечно-элементной сетки. Для этого 

переходим в модуль Mesh. В поле Object выбираем Assembly

. Далее нажимаем на панели инструментов команду  

Seed Edges  и выбираем отрезок расположенный внутри окружности, как 

показано на рисунке 2.21. Нажимае Done. В появившемся окне Local Seeds 

выберите Method: By number и укажите количество элементов равное 4, нажмите 

ОК. 

  

Рисунок 2.21 – Задание локального сгущения сетки 
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Выберите инструмент Seed Part Instance , в диалоговом окне Global Seeds 

(рисунок 2.22)  введите значение 1 для раздела Approximate global size и нажмите 

ОК. 

  

Рисунок 2.22 – Определение разметки 

детали 

Рисунок 2.23 – Метод построения сетки 

С помощью команды Assign Mesh Controls    выберем форму конечного 

элемента и методы построения сетки, для этого щелкните на область внутри 

окружности и нажмите Done. Во всплывшем окне Mesh Controls примените 

параметр Sweep и нажмите ОК. Далее щелкните на область вне окружности и 

нажмите Done. В появившемся окне Mesh Controls (рисунок 2.23) в разделе 

Element Shape выберите Quad, в разделе Algorithm: Medial axis. Нажмите ОК.  

Затем при помощи инструмента Mesh Part  создадим сетку (рисунок 2.24). 

Запуск на расчет 

Перейдите в модуль JOB (Рисунок 2.25). С помощью иконки  Create Job  

создайте задание на расчёт. В появившемся  окне Create Job,  присвойте заданию 

имя Static. 
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Рисунок 2.24 – Конечно-

элементная модель 
Рисунок 2.25 – Определение задания на расчет 

Для продолжения нажмите кнопку Continue. Задание на расчёт 

сформировано. В появившемся окне Job Manager (рисунок 2.26) нажмите Submit. 

Надпись Running в графе Status говорит о том, что расчет запустился. 

 

Рисунок 2.26 – Вызов Job Manager 

Анализ полученных результатов 

После успешного завершения расчёта, в окне Job Manager, в графе Status 

надпись Running поменяется на Completed. Для просмотра результатов расчёта, в 

окне Job Manager, нажмите Results или в списке Module выбираем Visualization. 
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В рабочей зоне экрана появится недеформированная конечно-элементная модель 

образца. 

Для вывода картины распределения эквивалентных напряжений по Мизесу 

на панели Field Output выберите Primary, S, Mises  и нажмите на инструмент Plot 

Contours on Deformed Shape (рисунок 3.1). Результаты выводятся в рабочей зоне 

экрана (рисунок 3.2). 

 

Рисунок 3.1 – Вывод картины распределение эквивалентных напряжений 

 

 

Рисунок 3.2 – Распределение эквивалентных напряжений (МПа) 

Для вывода значений графика значений J-интеграла в зависимости от шага 

расчета нажмите на вкладке главной панели Result => History Output, и, в 

появившемся окне History Output (рисунок 3.3) из списка выберите J-integral: J at 

J_CRACK-1__PICKEDSET6_Contour_5 in ELSET  ALL ELEMENTS, нажмите на 
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кнопку Plot. В рабочей зоне появится график значений J-интеграла (рисунок 3.5). 

Выполняем аналогичные действия для построения графика значений 

коэффициента интенсивности напряжений (рисунок 3.6), в окне History Output 

выбираем из списка Stress intensity factor K1: K1 at SIF_CRACK-

1__PICKEDSET6_Contour_5 in ELSET  ALL ELEMENTS. 

 

Рисунок 3.3 – Построение графика 

Для оценки полученных результатов, решим задачу аналитическим методом. 

Определим напряжения растягивающие образец: 

F F 1000
50 МПа,

S a b 2 10
    

 
 (3.1) 

где F – усилие, с которым растягивается образец, Н; 

 S – площадь поперечного сечения образца, мм; 

 a – толщина образца, мм; 

 b – ширина образца, мм. 

Коэффициент интенсивности напряжений рассчитывается по формуле: 

IK l Y( ),     (3.2) 

где l – длина трещины, мм; 
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Y(λ) – безразмерный коэффициент, зависящий от отношения длины трещины 

к размерам образца. 

Для данной схемы нагружения (рисунок 3.4) Y(λ) определяется следующим 

образом: 

2 3 4Y( ) 1,99 0,41 18,70 38,48 53,85 ,           (3.2) 

где λ – отношение длина трещины к толщине образца; 

Рассчитаем отношение длины трещины к толщине образца: 

l 2
0,2.

b 10
     (3.3) 

Подставив полученное значение в (3.2) определим Y(0,2): 

2 3 4Y(0,2) 1,99 0,41 0,2 18,70 0,2 38,48 0,2 53,85 0,2 2,43.           

 

Рисунок 3.4 – Схема нагружения образца 

По (3.2) рассчитаем значение коэффициента интенсивности напряжений: 

1/ 2

IK l Y( ) 50 2 2,43 171,83 МПа мм .         

Для упругого случая в плосконапряженном состоянии J-интеграл 

определяется по формуле: 

2 2
2I

5

K 171,83
J G 0,148 мДж /мм ,

E 2 10
   


 (3.4) 

где E – модуль Юнга, МПа. 
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Погрешность значений J-интеграла (0,141261 мДж/мм
2
) и коэффициента 

интенсивности напряжений (173,849 МПа·мм
1/2

), полученных в программном 

комплексе Abaqus, в сравнении с аналитическим решением (J = 0,148 мДж/мм
2
, 

KI = 171,83 МПа·мм
1/2

) составляет менее 5 %. 

 

Рисунок 3.5 – График зависимости значений J-интеграла от шага расчета 

 

 

Рисунок 3.6 – График зависимости значений коэффициента интенсивности 

напряжений от шага расчета 
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5. Моделирование местной потери устойчивости 

тонкостенных элементов 
Автор: Мальгин М.Г. 

Организация: 
Институт электросварки  

им. Е.О. Патона, г. Киев 

В рамках данной задачи производится расчет местной потери устойчивости 

отсека стенки металлической сварной балки (Рисунок 1.1). Двутавровая балка 

длиной 2970мм состоит из стенки толщиной 4мм и высотой 600мм. Верхний и 

нижний пояс балки имеет размеры 200х10мм. Стенка балки подкреплена тремя 

продольными ребрами жесткости с размерами 30х5мм лишь с одной стороны, а 

также пятью поперечными ребрами жесткости с размерами 70х10мм с двух 

сторон. Два поперечных ребра размещены в местах опоры балки на опоры, другие 

ребра сосредоточены в средней части балки. Все элементы балки из одной марки 

стали, с пределом текучести 480МПа. Нагрузка прикладывается таким образом, 

чтобы в балке возникал трехточечный изгиб. В расчете рассматривается ½ балки. 

 

Рисунок 1.1 – Общий вид сварной балки 

Для того, чтобы отразить местную потерю устойчивости в отсеке стенки при 

нагружении, балка имеет закрепления, ограничивающие ее перемещение в 

поперечном направлении. Закрепления находятся в местах размещения 

поперечных ребер жесткости. 

Решение задачи состоит из трех этапов: 
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1. Расчет в линейной постановке. Используется тип расчета Buckle, 

позволяющий определить формы потери устойчивости и соответствующие 

значения критических сил.  

2. Расчет в нелинейной постановке. Используется тип расчета Static, Riks, 

позволяющий оценить закритическое поведение конструкции с учетом 

физической и геометрической нелинейности. При этом в модели учитываются 

несовершенства геометрической формы элементов (начальное искривление). 

3. Выполнение сравнительного анализа результатов расчета в SIMULIA 

Abaqus с результатами аналитического решения и данными натурного 

эксперимента.  

РАСЧЕТ В ЛИНЕЙНОЙ ПОСТАНОВКЕ В SIMULIA Abaqus 

Система координат модели и система единиц измерения 

Построение расчетной модели и обработка результатов производится в 

декартовой системе координат. 

При моделировании принята следующая система измерений - SI. 

Таблица 2.1 – Система единиц измерения 

Длинна Сила Напряжения 

м кН кН/м2 

Геометрическая модель 

Открыть в дереве модели модуль PART. Для создания детали нажмите 

кнопку Create Part , или дважды нажмите на значке  в дереве 

модели. 
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Рисунок 2.1 – Создание геометрической модели 

В появившемся окне Create Part (Рисунок 2.2) введите имя Girder и 

следующие установки: 3D (трехмерное), Deformable (деформируемое) тело и 

Shell (оболочка), с типом Extrusion, в качестве базового свойства. В текстовом 

поле Approximate size введите 0.6. Нажмите Continue, чтобы закрыть диалоговое 

окно. 

  

Рисунок 2.2 – Построение эскиза Girder 

В появившемся рабочем поле, воспользовавшись инструментом , 

создайте отрезками сечение балки (с произвольными размерами), а затем с 
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инструментом  откорректируйте размеры: левый и правый свес поясов – 0.1; 

высота стенки – 0.6; продольные ребра – 0.3; расстояние между ребрами по 

высоте – 0.15. После задания координат каждого отрезка через , нажмите Esc 

для завершения (или среднюю кнопку мыши). Для использования инструмента 

 выделите элемент, введите нужный размер, нажмите Enter. В случае ошибки 

можно произвести отмену действия при помощи кнопки Cancel. Выйдете из 

режима Эскиз нажав кнопку Done. В появившемся диалоговом окне (Рисунок 

2.3), напротив Depth, введите 1.485.  

        

Рисунок 2.3 – Выдавливание сечения 

Создайте вторую деталь (Рисунок 2.4) с именем Stiffener и со следующими 

установками: 3D (трехмерное), Deformable (деформируемое) тело и Shell 

(оболочка), с типом Planar, в качестве базового свойства. В текстовом поле 

Approximate size введите 0.6. Нажмите Continue, чтобы закрыть диалоговое окно. 

В появившемся рабочем поле, воспользовавшись инструментом , 

создайте прямоугольник с размерами 0.6 по высоте и 0.14 по ширине. 

Прямоугольник должен размещаться в центре рабочего поля. Выйдете из режима 

Эскиз нажав кнопку Done.   
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Рисунок 2.4 – Построение эскиза Stiffener 

         

Рисунок 2.5 – Создание экземпляра сборки 

Сборка 

Перейти к модулю ASSEMBLY (Рисунок 2.5). Для создания сборочной 

единицы нажмите на иконку Create Part Instance  (либо в дереве модели 
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дважды нажмите по элементу  , либо воспользуйтесь  командами: меню 

Instance => Create). Появится окно со списком созданных деталей Parts. В нашем 

случае две детали, выберите их – они будут выделены, нажмите ОК. 

В модуле ASSEMBLY нажмите , выделите поперечное ребро балки и 

нажмите Done. Появившиеся значения координат первой точки (0.0,0.0,0.0) 

оставите по умолчанию и нажмите Enter. Для второй точки укажите координаты 

0.0,0.0,0.135 и нажмите OK. В результате поперечное ребро сместиться вдоль 

балки на указанную величину. Нажмите  , снова выделите поперечное ребро и 

нажмите Done. В появившемся окне (Рисунок 2.6), в рамке Direction 2, укажите 1 

под Number, в рамке Direction 1 нажмите  и укажите в модели любую линии 

вдоль балки, введите 1.275 под Offset, после чего нажмите ОК. Скопируйте третье 

поперечное ребро, аналогично описанной выше процедуре, на величину 0.075 

(Рисунок 2.7). 

         

Рисунок 2.6 – Копирование второго ребра 
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Рисунок 2.7 – Копирование третьего ребра 

В модуле ASSEMBLY нажать . В появившемся диалоговом окне введите 

имя Total, в Intersecting Boundaries выберите Retain и нажмите Continue 

(Рисунок 2.8), выделите все элементы и нажмите Done. 

         

Рисунок 2.8 – Сшивка элементов геометрической модели  

Свойства 

Для создания материала с необходимыми свойствами для расчета, в дереве 

модели дважды нажмите по контейнеру Materials. В появившемся окне Edit 

Material введите имя Steel. В меню редактора выберите 
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Mechanical=>Elasticity=>Elastic и введите значение модуля упругости 

2,0e8 kN/m
2 

и коэффициента Пуассона 0.3 (Рисунок 2.9) и нажмите ОК. Для 

создания сечения элементов откройте диалоговой окно Create Section (вызов 

возможен либо из Дерева модели, либо через иконку ). В диалоговом окне 

Create Section введите имя сечения t-4, в категории выберите Shell, укажите тип 

Homogoneous и нажмите Continue. В появившемся окне редактора сечений Edit 

Section, в качестве материала укажите созданный ранее материал Steel и укажите 

Shell Thickness Value - 0.004, после чего нажмите OK. Повторите процедуру с 

созданием еще двух сечений с именами t-5, t-10 и толщинами 0.005, 0.01. 

       

Рисунок 2.9 – Определение материала и толщины элемента 

Следующим шагом является присвоение созданных сечений элементам 

балки. Для этого нажмите  Assign Section в текущей панели инструментов 

(либо дважды нажмите по элементу  в дереве модели, либо используйте команду 

меню: Assign => Section). С помощью мыши выделите стенку балки, она будет 

подсвечена красным цветом (Рисунок 2.10) и нажмите Done. В появившемся окне 

выберите сечение t-4 и подтвердите выбор нажатием кнопки ОК. Повторите 

процедуру для продольных ребер (сечение t-5), поясов балки (сечение t-10), ребра 

по середине балки (сечение t-5) и остальных ребер (сечение t-10) (Рисунок 2.11).  
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Рисунок 2.10 – Присвоение сечения t-4 стенке балки 

       

      

Рисунок 2.11 – Присвоение сечений остальным элементам балки 
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Определение процедуры анализа 

В дереве модели дважды нажмите по контейнеру Step. В окне Create Step 

введите имя нового анализа – Linear buckling. Выберите Procedure type=>Linear 

perturbation. Из списка выберите линейный расчет устойчивости Buckle и 

нажмите Continue (Рисунок 2.12). В появившемся окне Edit Step укажите число 

форм - 3  и нажмите ОK. 

  

Рисунок 2.12 – Определение процедуры анализа линейной устойчивости 

Нагрузки и граничные условия 

Для задания граничных условий и нагрузки перейдите в модуль LOAD. Для 

задания нагрузки нажмите , в появившемся окне Create Load выберите 

Concentrated force, нажмите Continue. Затем выберите верхний узел стенки как на 

Рисунке 2.13 и нажмите Done. В появившемся окне Edit Load введите величину 

вертикальной силы CF2 =-0.5 и нажмите ОК. Для задания граничных условий 

нажмите , в появившемся окне Create Boundary Condition выберите 

Step=>Initial, затем выберите Symmetry/Antisymmetry/Encastre и нажмите 

Continue. После этого выделите все элементы и линии находящиеся в плоскости 

симметрии балки (Рисунок 2.14) и нажмите Done. В появившемся окне Edit 
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Boundary Condition выберите ZSYMM (U3=UR1=UR2=0) и нажмите ОК. Затем 

еще раз нажмите , в появившемся окне Create Boundary Condition выберите 

Displacement/Rotation и нажмите Continue. Выделите линии под поперечным 

ребром на конце балки как на Рисунок 2.15 и нажмите Done. В появившемся окне 

Edit Boundary Condition укажите закрепление U2 и нажмите ОК. Повторите 

процедуру для поперечных закреплений балки выбрав четыре узла в местах 

прикрепления ребер к стенке (Рисунок 2.16) и укажите закрепление U1.  

       

 

Рисунок 2.13 – Задание нагрузки  
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Рисунок 2.14 – Задание граничных условий симметрии  

            

Рисунок 2.15 – Задание граничных условий опоры балки 

          

Рисунок 2.16 – Задание граничных условий поперечных закреплений балки 
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Конечно-элементная модель 

Перейдите в модуль MESH, выберите Part=>Total (Рисунок 2.17). Нажмите 

, в появившемся диалоговом окне Global Seeds укажите средний размер 

конечных элементов 0.047, нажмите OK и Done. Нажать  , выделите все 

элементы модели и нажмите Done. В появившемся диалоговом окне Mesh 

Controls выберите форму элементов Quad, алгоритм Medial axis с указанием 

Minimize the mesh transition (Рисунок 2.18), после этого нажмите ОК и Done. 

Нажмите   и Yes для нанесения сетки конечных элементов.   

          

Рисунок 2.17 – Задание среднего размера конечных элементов 

 

         

Рисунок 2.18 – Настройки структуры сетки конечных элементов 
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Запуск на расчет 

Перейдите в модуль JOB (Рисунок 2.19). С помощью иконки Create Job 

(либо команды меню Job => Create, или дважды нажав по элементу в дереве 

модели) создайте задание на расчет. В появившемся окне Create Job введите 

заданию имя Linear_buckling и нажмите Continue. 

 
 

Рисунок 2.19 – Определение задания на расчет 

Чтобы запустить на расчет нажмите  Job Manager (Рисунок. 6.20), 

выберите задание Linear_buckling и нажмите Submit (либо раскройте элемент 

дерева модели, нажмите правой кнопкой по заданию Linear_buckling и 

выберите Submit). 

 

 

Рисунок 2.20 – Вызов Job Manager 
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Анализ полученных результатов 

Для отображения результатов расчета, в дереве модели нажмите правой 

кнопкой мыши на Linear_buckling и выберите Results (Рисунок 3.1). Для 

отображения деформированного вида нажмите . На Рисунке 3.2 представлена 

первая форма местной потери устойчивой стенки балки в линейной постановке. 

Ниже указана величина критической силы Mode1: Eigenvalue = 995.19 (КН). 

 

Рисунок 3.1 – Переход в режим анализа результатов расчета 

 

Рисунок 3.2 – Отображение формы потери устойчивости 
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РАСЧЕТ В НЕЛИНЕЙНОЙ ПОСТАНОВКЕ 

Получение перемещений узлов из линейного расчета  

Несовершенство геометрической формы элементов для нелинейного расчета 

будет создаваться на основе первой формы потери устойчивости, с введением 

масштабного коэффициента. Для этого, не закрывая созданный ранее проект, в 

дереве модели нажмите правой кнопкой мыши на Model-1 и выберите Edit 

Keywords (Рисунок 3.1). В появившемся диалоговом окне Edit keywords, Model: 

Model-1, в самом конце, между стройками «*Output field variable=PRESELECT» и 

«End Step» введите две строки: «*NODE FILE» и «U». Введенные команды, после 

повторного выполнения расчета модели, откроют доступ к перемещениям узлов 

модели исходя из полученных форм потери устойчивости. Значения перемещений 

будут применяться программой для преобразования геометрии расчетной модели. 

После введения команд нажмите ОК и запустите задачу снова на расчет.  

      

Рисунок 3.1 – Внесение дополнительных команд в расчетную модель 

Пластические свойства стали 

В дереве модели откройте ранее созданный материал стали 

Materials(1)=>Steel. В появившемся окне Edit Material, в меню редактора, 

выберите Mechanical=>Plasticity=>Plastic и введите значение предела текучести 
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480000 (кН/м
2
) и величину начальных пластический деформаций 0. После этого 

нажмите ОК. 

      

Рисунок 3.2 – Переход в режим анализа результатов расчета 

Определение нелинейной процедура расчета 

Перейдите в модуль STEP, нажмите . В диалоговом окне Step Manager 

выберите ранее созданную процедуру расчета Linear buckling, нажмите Rename и 

введите новое название «Nonlinear buckling». Выберите снова процедуру расчета 

NonLinear buckling и нажмите Replace. В открывшемся диалоговом окне укажите 

новую процедуру – General, выберите Static, Riks (Рисунок 3.3). В открывшемся 

диалоговом окне Edit Step установите переключатель на учет геометрической 

нелинейности и нажмите ОК (Рисунок 3.3).  
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Рисунок 3.3 – Определение процедуры нелинейного расчета 

Задание геометрических отклонений  

В дереве модели нажмите правой кнопкой мыши на Model-1 и выберите Edit 

Keywords. В появившемся диалоговом окне Edit keywords, Model: Model-1, между 

строками «STEP: Nonlinear buckling» и «*Step, name=’Nonlinear buckling’, 

ngeom=Yes» введите команды «*IMPERFECTION, FILE=Linear_buckling, 

STEP=1» и «1, 2e-4». В Первой команде указывается файл с результатами расчета 

линейной устойчивости.  Вторая команда указывает программе, что координаты 

узлов модели в ходе расчета изменятся, исходя из перемещений по 1 форме 

потери устойчивости с максимальной величиной отклонения в 2мм (Рисунок 3.4).  

В этом же диалоговом окне удалите все строки, в которых вначале присутствует 

слово «Conflicts» (Рисунок 3.4), после этого нажмите ОК.  

Запуск на расчет  

Перейдите в модуль JOB. Создайте новое задание на расчет с введением 

имени Nonlinear_buckling. Запустите задание на расчет. 
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Рисунок 3.4 – Изменение геометрической формы модели для расчета 

     

Рисунок 3.5 – Построение диаграммы равновесного состояния 
 

Анализ полученных результатов 

Для отображения результатов расчета, в дереве модели нажмите правой 

кнопкой мыши на Nonlinear_buckling и выберите Results. Для отображения 

деформированного вида нажмите . Для построения диаграммы равновесного 

состояния модели перейдите в Results=>History Output. В открывшемся 

диалоговом окне выберите Load proportionality factor: LPF for Whole Model и 

нажмите Plot (Рисунок 3.5). В результате программа построит график.  Из данного 

графика получается, что критическая сила для модели составляет LPF=1044.15 
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(кН). При этом важно отметить, что с уменьшением сетки конечных элементов 

данная величина будет уточняться. 

СРАВНИТЕЛЬНЫЙ АНАЛИЗ С АНАЛИТИЧЕСКИМ РЕШЕНИЕМ И 

ЭКСПЕРИМЕНТОМ 

Аналитический расчет 

Аналитический расчет основывался на теории устойчивости пластин 

подкрепленных ребрами жесткости [1]. Данная теория допускает учет малых 

упруго-пластических деформаций. Для определения критической силы, при 

которой возникает местная потеря устойчивости стенки балки, использовалась 

формула (4.1), суть которой заключается в определении отношений компонентов 

действующих напряжений σx, τxz и критических напряжений σx,cr , τxz,cr  в пластине. 

В формуле (4.1) коэффициент ϖ1 отражает особенности поведения пластины в 

упругопластической и закритических стадиях. Если при заданной нагрузки левая 

часть уравнения получается больше 1.0, соответственно пластина теряет 

устойчивость. Значения для формулы (4.1) при действии критической силы Pcr 

приведены в таблице 4.1. 
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 (4.1) 

Таблица 4.1 – Значения для формулы (4.1) при действии критической силы Pcr 

σx, kN/m
2 

σx,cr, kN/m
2
 τxz, kN/m

2
 τxz,cr, kN/m

2
 ϖ1 Pcr, kN 

194280 364200 173640 228345 1.048 952 

Натурный эксперимент 

Данные натурного эксперимента были взяты из источника [2]. Размеры 

экспериментальной балки и свойства стали соответствуют приведенным ранее. На 

Рисунке 4.1 представлен общий вид балки на испытательном стенде и вид потери 
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устойчивости. На Рисунке 4.2 приведена диаграмма равновесного состояния, 

полученная в ходе эксперимента.   

     

Рисунок 4.1 – Общий вид балки на испытательном стенде 

     

Рисунок 4.2 – Диаграмма равновесного состояния 

Сравнительный анализ 

В Таблице 4.2 приведены значения критических сил, полученных из 

линейного и нелинейного расчета устойчивости в SIMULIA Abaqus, а также 

аналитического расчета и натурного эксперимента. На Рисунке 4.3 приведено 
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сравнение равновесного состояния балки, полученного из SIMULIA Abaqus и 

натурного эксперимента.      

Таблица 4.2 – Значения критических сил Pcr, кН 

Линейный расчет
 

Нелинейный расчет Аналитический расчет Эксперимент 

995,19 1044,15 952 968 

     

Рисунок 4.3 – Сравнение диаграмм равновесного состояния 
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6. Моделирование процесса мягкого обжатия на 

стадии неполной кристаллизации 
Автор: Черкашина Т.И. 

Организация: ЛГТУ, г. Липецк 

В рамках данной задачи моделируется процесс мягкого обжатия на стадии 

неполной кристаллизации в виде трехмерной задачи. На рисунке 1.1 представлена 

принципиальная схема задачи. 

    

 

 

Рисунок 1.1 – Постановка задачи 

При построении модели процесса упругопластического деформирования 

непрерывного слитка в двухфазном состоянии приняты следующие допущения 

[1]:  
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 моделируется состояние только твердой фазы металла, а присутствие 

жидкого расплава не учитывается;  

 в любой момент времени кристаллизации толщина твердой фазы постоянна 

по всему периметру поперечного сечения сляба; 

 в пределах твердой фазы металл рассматривается как однородная 

изотропная среда;  

 деформирующие ролики являются абсолютно жесткими.  

В качестве моделируемого материала используется свинец. Напряжения 

текучести материала  при различной скорости деформации в зависимости от 

величины пластической деформации представлены в таблице 1.1. 

Таблица 3.1 – Параметры материала 

Напряжения 

текучести, ×10
6 

Пластическая 

деформация 

Скорость 

деформации 

2,0 0 0 

6,0 0,1 0 

8,0 0 0,4 

11,0 0,05 0,4 

13,0 0,1 0,4 

17,5 0,2 0,4 

22,0 0,3 0,4 

27,0 0,5 0,4 

33,0 0,8 0,4 

34,0 1 0,4 

10,0 0 9 

14,0 0,05 9 

17,0 0,1 9 

22,0 0,2 9 

26,0 0,3 9 

32,0 0,5 9 

38,0 0,8 9 

40,0 1 9 

12,0 0 100 

17,0 0,05 100 

20,0 0,1 100 

25,0 0,2 100 

28,0 0,3 100 

34,0 0,5 100 

41,0 0,8 100 

43,0 1 100 
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Основные физико-механические свойства материала: плотность – 11300кг/м
3
, 

модуль упругости – 14000 МПа, коэффициент Пуассона – 0,4. 

Исходные размеры целого образца Н0 = 16 мм, В0 = 72 мм, 

L0 = 100 мм, толщина стенки 4 мм. Моделируется 1/4 часть образца. Диаметр 

валка – 125мм, длина – 125 мм. Угловая скорость вращения валка – 1,5708 рад/с. 

Начальная скорость движения заготовки – 0,2 м/с. Коэффициент трения – 0,2. 

Моделируется режим обжатия 3мм.  

Приведено сравнение численного и аналитического решений для свинца. 

1. Система координат модели и система единиц измерения 

Построение расчётной модели и обработка результатов производится в 

декартовой системе координат в международной системе единиц, СИ. 

Таблица 2.1 – Система единиц измерения 

Длина Н Масса Время Температура Напряжения Плотность 

м 𝑁 𝑘𝑔 𝑠 ºC Па 𝑘𝑔/𝑚3 

Геометрическая модель 

Откроем в дереве модели модуль PART. Для создания детали нажмите 

кнопку Create Part   , или дважды щёлкните на значке  в дереве 

модели. 
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Рисунок 2.1 – Создание геометрической модели 

В появившемся окне Create Part (Рисунок 2.2) дайте детали имя Slab и 

примите следующие установки: 3D (трехмерного), Deformable (деформируемого) 

тела и Solid (твердое) в качестве базового свойства. В текстовом поле Approximate 

size наберите 0,1. Щелкните Continue, чтобы закрыть диалоговое окно 
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Рисунок 2.2 – Построение эскиза модели 

В появившемся рабочем поле, воспользовавшись функцией Create Lines: 

Connected, создаём ¼ часть образца. Затем воспользовавшись инструментом,  

задайте нужный размер в нижнем поле, нажмите Enter. Аналогично поступите с 

другими граням. После задания координат каждой стороны сляба, подтверждаем 

свой выбор клавишей Enter (или средней кнопкой мыши). В случае ошибки 

можно произвести отмену действия при помощи кнопки Cancel или функции 

Delete.  (Рисунок 2.2). Выходим из режима Эскиз,  нажав кнопку Done. 

В появившемся рабочем окне задаем величину выдавливания Depth равной 

0,1. Затем нажимаем OK или Enter (Рисунок 2.3). 

 

Рисунок 2.3 – Выдавливание  модели 

В результате получим ¼ часть сляба, как  показано на Рисунке 2.4 
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Рисунок 2.4 –Модель 1/4 сляба 
 

После создания сляба, нам необходимо начертить валок. Валки будут 

абсолютно одинаковыми, поэтому достаточно будет начертить только один, а 

точнее 1/4 часть валка. 

Для этого откроем в дереве модели модуль PART. Для создания детали 

нажмите кнопку Create Part   , или дважды щёлкните на значке  в 

дереве модели. 

В появившемся окне Create Part дайте детали имя  Rolling и примите 

следующие установки: 3D (трехмерного), Analytical rigid (аналитически жесткая) 

тела и Shell (оболочка) в качестве базового свойства. В текстовом поле 

Approximate size наберите 0,2. Щелкните Continue, чтобы закрыть диалоговое 

окно. 
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Рисунок 2.5 – Построение эскиза модели 

В появившемся рабочем поле, воспользовавшись инструментом , 

создайте часть круга. Затем воспользовавшись инструментом,  задайте 

нужный размер в  нижнем поле равным 0,125. Подтверждаем свой выбор 

клавишей Enter (или средней кнопкой мыши). В случае ошибки можно 

произвести отмену действия при помощи кнопки Cancel  или функции Delete. 

(Рисунок 2.5). Выходим из режима Эскиз,  нажав кнопку Done. 

В появившемся рабочем окне задаем величину выдавливания  Extrusion 

depth равной 0,125. Затем нажимаем ОК. 

 

Рисунок 2.6 – Выдавливание  модели 
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Модель материала 

Создадим материал с необходимыми теплофизическими свойствами. В 

Дереве Модели дважды кликните по контейнеру Materials, чтобы создать новый 

материал. В появившемся окне Edit Material зададим имя Lead. В меню редактора 

выберем Mechanical=>Elastic=>Elastic и введем значение модуля Юнга 

14000000000 МПа и коэффициента Пуассона 0,4. Для задания значения 

пластических свойств материала выберем Mechanical => Plastic=> Plastic и 

введем значения таблицы 1.1, при этом необходимо поставить галочку для учета 

скорости деформации. Плотность свинца задаётся в окне  General=>Density 

равную 11300 kg/m3 (Рисунок 2.7). 

 

Рисунок 2.7 – Определение модели материала 

Теперь перейдём к определению сечения. Открываем диалоговой окно Create 

Section (вызов возможен либо из Дерева модели, либо через иконку ). В 

диалоговом окне Create Section присвоим сечению имя Lead. Выберите в 

соответствующих списках Solid, Homogeneous и щелкните Continue. В 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 

 

103 

появившемся окне редактора сечений Edit Section,  в качестве материала 

необходимо указать созданный ранее материал Lead. 

Следующим шагом присвоим построенное сечение ранее созданному слябу. 

Для этого используем иконку  Assign Section в текущей панели инструментов 

(либо дважды щелкаем по элементу  в дереве модели Slab, либо используем 

команды меню: Assign => Section). С помощью мыши выделите сляб, он будет 

подсвечен красным цветом. Нажмите Done. В появившемся окне (Рисунок 2.8), 

выберите созданное сечение и подтвердите выбор нажатием кнопки ОК. 

 

Рисунок 2.8 – Присвоение сечения геометрической модели 

Теперь необходимо определить базовую точку отсчета. Для этого в  

верхней панели меню находим команду Tools=> Reference Point. Базовой 

точкой будет центр валка. 

Далее определяем поверхность контакта сляба  с валком.  Для этого в 

Дереве модели выбираем валок Slab=>Surface. Выделяем весь сляб, нажимаем 

Enter, теперь нам необходимо выделить плоскость с какой будет контакт.  

Выбираем плоскость  и соглашаемся. (Рисунок 2.9). 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 

 

104 

 

Рисунок 2.9-Определение поверхности контакта сляба 
 

Сборка 

Перейдём к модулю ASSEMBLY. Для создания сборки необходимо нажать на 

иконку Create Part Instance  (либо в дереве модели дважды кликнуть по 

элементу  , либо воспользоваться  командами: меню Instance => Create). 

Появится окно со списком созданных деталей Parts. В нашем случае деталей две, 

выберем их – они будут выделены красным цветом. В разделе Instance Type 

укажите Dependent и подтвердите выбор, нажав ОК.  

 

Рисунок 2.10 – Создание экземпляра сборки 
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Теперь необходимо правильно расположить детали сборки и выровнять 

их. Для этого воспользуемся функцией Rotate Instance (вращать элемент), 

выделим на слябе 2 точки нужной плоскости и развернем образец на -90
0
. 

Затем воспользовавшись функцией  Translate Instance (перемещать 

 

 

Рисунок 2.11 – Конечная сборка 
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элемент), переместим сляб по краю валка, как показано на рисунке 2.11. 

После этого воспользуемся командой Tools=>Partition=>Face=>Use shortest 

path between 2 points и выберем на валке 2 точки, создав разделение как на 

рисунке 2.11. Переместим валок относительно вновь созданной линии на 

валке. 

Также нужно определить поверхность контакта валка со слябом. Для 

этого в Дереве модели выбираем валок  Constraints=>Rigid Body=> Continue.  

В появившемся окне выбираем Analytical Surface и стрелочку Edit Selection, 

в нижней панельки щелкаем на Geometry. Выбираем поверхность контакта 

валка, она окрашена в коричневый цвет  Brown, также укажите  RP, выбрав 

центр валка, и нажимаем Enter (Рисунок 2.12). 

 

Рисунок 2.12-Определение поверхности контакта валка 

В контейнере Assembly проверим наличие трех поверхностей Assembly 

=> Surfaces: поверхность контакт у валка, поверхность контакта у сляба и 

одна внешняя поверхность сляба (появляются автоматически) (рисунок 2.13). 

Если какая-либо из плоскостей отсутствует, создадим её с помощью 

Surface=>Create. 
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Рисунок 2.13 – Создание необходимых для анализа плоскостей 
 

Определение процедуры анализа 

В Дереве Модели дважды щелкните по контейнеру Step. В окне Create Step 

задайте имя нового шага анализа –  Prokatka. Задайте Dynamic,Explicit и 

щелкните Continue (Рисунок 2.14).  

 

Рисунок 2.14 – Определение процедуры анализа 
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В появившемся окне Edit Step,  задаём расчёт установившегося режима c 

временным период 1. 

Также необходимо настроить массовый масштаб, для этого воспользуемся 

командой Mass Scaling =>Use scaling definitions below. В нижней части окна 

нажмите на клавишу Create. В появившемся окне зададим следующие настройки, 

как на рисунке 2.15. 

 

Рисунок 2.15 – Настройки массового масштаба 

В появившемся окне Edit Step,  установите настройки солвера и нажмите ОK. 

Контактные взаимодействия 

Зададим трение между поверхностью сляба и валком. Для этого в окне Create 

Interaction Properties (модуль Interaction) зададим контакт, дав ему имя friction. В 

появившемся окне выберем  Mechanical=>Tangential Behavior=>Penalty, зададим 

установки как на рисунке 2.16. 
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Рисунок 2.16 – Определение свойств контакта 

Теперь необходимо определить контакт между валком и слябом. Для этого в 

окне Create Interaction (модуль Interaction) выберите Create=>Surface-to-surface-

contact и нажмите Continue. Выделите внешнюю поверхность валка и сляба, 

нажмите OK. (Рисунок 2.17). 

 

Рисунок 2.17– Задание контакта 
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Нагрузки и граничные условия 

В окне Create Boundary Condition выберите Initial граничных условий, 

категория Mechanical тип шага Symmetry/Antisymmetry/Encastre, затем нажмите 

Continue выберите поверхность у сляба и поставьте настройки как на рисунке 

2.18. Поверхность будет симметрична оси Z. 

 

Рисунок 2.18 – Задание граничных сляба 

В окне Create Boundary Condition выберите Initial граничных условий, 

категория Mechanical тип шага Symmetry/Antisymmetry/Encastre, затем нажмите 

Continue выберите поверхность у сляба и поставьте настройки как на рисунке 

2.19. Поверхность будет симметрична оси Y. 
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Рисунок 2.19 – Задание граничных условий сляба 

В окне Create Boundary Condition выберите Initial граничных условий, 

категория Mechanical тип шага Displacement/Rotation, затем нажмите Continue 

выберите RP на валке и поставьте галочки у U1, U2, U3, UR1, UR2 как  на 

рисунке 2.20, кроме UR3. 

 

Рисунок 2.20 – Задание граничных условий валка 
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Теперь необходимо задать вращение валку, для этого воспользуемся 

функцией  Create BC:  в шаге выбираем Prokatka, в категории Mechanical, в 

типе Velocity /Angular velocity. Выделяем RP на валке. Нажмите Continue и в 

появившемся окне задайте скорость вращения валка по Z равную -1,5708 рад/с 

(Рисунок 2.21).  

 

Рисунок 2.21 – Задание вращения валка 

Далее необходимо задать предопределенное поле перемещения сляба, для 

обеспечения захвата полосы валками. Для этого в меню выберите Predefined 

Field и в появившемся окне выберите шаг Initial, категорию Mechanical  тип 

Velocity и нажмите продолжить (Рисунок 2.22). 

 

Рисунок 2.22-Параметры перемещения сляба 

Выберите поверхность необходимую для перемещения. Далее в 
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появившемся окне задаем скорость перемещения сляба по оси Х равную -0,2 

(Рисунок 2.23). 

 

Рисунок 2.23-Задание скорости перемещения сляба 
 

Конечно-элементная модель 

При расчёте задачи необходим определённый тип конечных элементов. В окне 

Element Type (Mesh => Element Type) выберите следующий тип КЭ – C3D8R 

(Рисунок 2.24). И нажмите OK. 

 

Рисунок 2.24 – Выбор типа конечных элементов 
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С помощью инструмента Partition Cell: Extend Face   выберете плоскость 

показанную на рисунке 2.25(а) и завершите разбиение сляба, нажав на клавишу 

Create Partition в окне инструкций. 

Для задания размеров конечных элементов на гранях воспользуемся 

инструментом  Seed Adges (применив параметр Local seed=>By number) 

задайте количество элементов на вертикальных гранях выделенных красным на 

рисунке 2.25(б) и укажите число элементов Number of elements 3. Во вкладке 

Constraints окна Local Seeds укажите, Do not allow the number of elements to 

change, чтобы построение сетки происходило строго по созданным параметрам. 

Нажмите OK. Повторите процесс для оставшихся двух вертикальных граней 

число элементов равное 6, а для продольных горизонтальных – 15 (Рисунок 

2.25(б) посередине). Для торцевых горизонтальных граней укажите число 

элементов равное 7, и способ сгущения Bias => Double. Sizing Controls => Bias 

ratio (>=1) = 10. Произведите разбиение, воспользовавшись инструментом  

Mesh Part Instance  .  
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Рисунок 2.25 – Построение конечно-элементной модели 

Валок в нашей постановке задачи абсолютно жесткий и для него строить 

сетку не нужно. Он подсветится оранжевым цветом. 

Запуск на расчет 

Перейдите в модуль JOB (Рисунок 2.27). С помощью иконки  Create Job  

(либо команд меню  Job => Create, или дважды кликнув по элементу  в дереве 

модели) создайте задание на расчёт. В появившемся  окне Create Job,  присвойте 

заданию имя Soft_Reduction. 
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Рисунок 2.27– Определение задания на расчет 

Для продолжения нажмите кнопку Continue. Задание на расчёт сформировано. 

Чтоб запустить расчёт, вызовите  Job Manager (рис. 2.28) (либо раскройте 

элемент дерева модели, кликните правой кнопкой по заданию Soft 

reduction и выберите Submit, либо командами меню Job => Manager). 

В появившемся окне Job Manager нажмите Submit. Надпись Running 

говорит о том, что расчет запустился. 

 

Рисунок 2.28 – Вызов Job Manager 

Анализ полученных результатовНа рисунке 3.1 представлены поле 

распределений эквивалентной пластической деформации.  
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Рисунок 3.1 – Распределение поля эквивалентной пластической деформации 

 Для того чтобы увидеть целую модель сборки воспользуемся View=>ODB 

Display Options=>Mirror/Pattern=>Mirror planes. 

Чтобы оценить адекватность модели необходимо произвести сравнение 

математической модели с реальным процессом. Воспользуемся физическим 

моделированием процесса мягкого обжатия на  стадии неполной кристаллизации. 

Моделирование обжатия сляба с жидкой сердцевиной осуществлено на модели, 

выполненной из сплава Вуда и тарированных сферических элементов (дроби) из 

свинца, и представляющей замкнутую оболочку. Замкнутая оболочка позволяет 

создавать различное внутреннее давление, имитирующее ферростатическое, и 

моделировать деформирование сляба на различных стадиях разливки. 

Деформирование модельных образцов осуществили на кафедре ОМД 

Липецкого государственного технического университета на лабораторном стане 

250. Суммарное обжатие за 2 прохода образцов составило 3 мм (за первый проход 

2 мм  и  за второй проход 1 мм).  

После деформирования выполнили разрез образцов поперек направления 

прокатки. Первичный визуальный осмотр сечений показал, что основная 

деформация зерен произошла вдоль узких граней, в то время как вдоль широкой 

они остались недеформированными. Характерное сечение представлено на рис.  
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3.2,а, где срез зерен по узкой грани имеет вид эллипса,  а по широкой – 

окружности.  

Так как свинцовая дробь, расположенная вдоль широкой и узкой грани, в 

процессе деформирования по-разному изменила первоначальную форму, то для 

дальнейшего исследования были выбраны фрагменты, в которых форма дроби 

представляла наибольший интерес для изучения деформированного состояния 

образцов после обжатия. Перед извлечением положение зерен исследуемого 

фрагмента фотографировали с использованием координатной сетки,  модельный 

образец локально нагревали, и у высвобожденного зерна измеряли главные 

 

 

                                                                   

а) 
 

 

  

                                                   б) 

Рис. 3.2 - Образец после деформирования с 16 мм на 13 мм 

а) - внешний вид поперечного сечения; б) - форма дроби, извлеченной из 

образца 

Y 

X 
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диагонали эллипсоида – 1 , 2 , 
3  (рис. 3.2,б). В окрестности рассматриваемого 

зерна значения главных деформаций находятся как 

d

d
 1

1


, 

d

d
 2

2


, 

d

d
 3

3


,       (1) 

где 1 , 2 , 
3  – главные относительные деформации; d  – исходный диаметр 

дроби. Далее по известным зависимостям можно определить другие 

характеристики деформированного состояния  [2,3]. 

В ходе сравнения результатов физической и математической модели была 

определена максимальная погрешность, и она составила 6,17% . Для получения 

более достоверных данных необходима модель с другой структурой сетки, что 

недопустимо у студенческой версии. Математическая модель процесса мягкого 

обжатия на стадии неполной кристаллизации, разработанная в Abaqus Student 

Edition, адекватна физической модели и  в дальнейшем может быть реализована в 

полной версии Abaqus применительно для стали уже с учетом жидкой фазы. 

Список использованных источников 

1. Мазур И. П., Барышев В. В., Седых М. О. Постановка задачи упруго-

пластического деформирования непрерывного слитка с жидкой 

сердцевиной //Известия вузов. Черная металлургия. – 2003. – №. 1. – С. 29-

32. 

2. Тищук Л. И. и др. ИССЛЕДОВАНИЕ КАРТИНЫ ТЕЧЕНИЯ МЕТАЛЛА 

ПРИ ОСАДКЕ //Вестник Магнитогорского государственного технического 

университета им. ГИ Носова. – 2017. – Т. 15. – №. 3. 

3. Мазур И. П., Смирнов Е. Н., Черкашина Т. И. Физическое моделирование 

деформирования сляба на стадии неполной кристаллизации. – 2011 

  



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 

 

120 

7. Анализ контактных напряжений от болтовых 

соединений 

Авторы: 
Арсланова Л.И.  

Султанов И.М. 

Организация: УГНТУ, г. Уфа 

В рамках данной задачи производится моделирование двух прямоугольных 

пластин, между которыми находится прокладка. Они закреплены друг с другом 

болтом и гайкой. Пластины сделаны из латуни, прокладка из резины, а болты и 

гайки из стали.  

Геометрическая модель 

Откроем в списке Module модуль PART. Для создания детали нажимаем 

кнопку Create Part . В появившемся окне Create Part дайте детали имя Plate и 

примем следующие установки: 3D (трехмерное) Deformable (деформируемое)  

Solid (твердое) тело с особенностью типа Extrusion (вытеснение). В текстовом 

поле Approximate size наберите 20 (Рисунок 2.1). Подтвердим заданные свойства 

нажатием кнопки Continue. 

Построение пластины 

 

Рисунок 2.1 – Построение эскиза модели 
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В появившемся рабочем поле, построим прямоугольник с двумя 

отверстиями. Выбираем команду Create Lines: rectangle  и строим 

прямоугольник с координатами (0.0) и (10, 2.5). Для построения отверстий 

воспользуемся командой  . Первое отверстие строим с координатами (2,5; 1,25) 

и второе (7,5; 1,25). Радиусы отверстий равны 0,25. В случае ошибки можно 

произвести отмену действия при помощи кнопки Cancel. Нажав кнопку Done 

перейдем к следующему шагу построения модели - в окне Edit Base Extrusion в 

поле Depth вводим толщину стенки пластины равной 0.5. Нажимаем ОК (Рисунок 

2.2). 

 

Рисунок 2.2 –Трехмерная модель пластины 

Далее вас ждет разделение пластины на сечения с использованием базовых 

плоскостей. В панели меню выберите Tools→Datum (Рисунок 2.3) 

 

Рисунок 2.3 –Панель меню 
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Появляется окно Create Datum, в котором выбираем тип Plane и метод 

Offset from plane и выделяем боковую грань пластины (Рисунок 2.4) 

 

Рисунок 2.4 – Боковая плоскость пластины 

Далее выбираем в панели инструкций Enter Value, вводим значение 1.9,  

нажимаем Enter (Рисунок 2.5).  

 

Рисунок 2.5 – Создание вертикальной базовой поверхности 

Аналогично создаем 5 таких плоскостей со значениями в панели инструкций 2.5, 

3.1, 6.9, 7.5, 8.1 (Рисунок 2.6) 
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Рисунок 2.6 – Создание вертикальных базовых поверхностей 

Затем в панели меню снова выбираем Tools→Datum, для создания базовой 

поверхности, но уже выделяя нижнюю грань плиты. В области запроса вводим 

значение 1.25 (Рисунок 2.7) 

 

Рисунок 2.7 – Создание горизонтальной базовой поверхности 

Далее разделяем пластину с использованием базовых плоскостей, которые 

вы только что создали. Нажимаем Tools→Partition. В появившемся окне Create 

Partition выбираем Cell и Use datum plane (Рисунок 2.8) 
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Рисунок 2.8 - Окно Create Partition 

Выделяем базовую поверхность в графической части и нажимаем Create 

Partition (Рисунок 2.9). 

 

Рисунок 2.9 – Создание сечений на пластине 

Повторите эту процедуру для всех вертикальных базовых плоскостей, 

который вы создали. Обратите внимание, что после того, как плита была 

секционирована, вы должны сначала выделить ячейку или ячейки, которая вам 

нужна (Рисунок 2.10) 

 

Рисунок 2.10 –Трехмерная модель пластины 
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Построение прокладки 

Построение прокладки производится аналогично построению пластины, за 

исключением толщины стенки, которая имеет значение 0.125 и имя Thin (Рисунок 

2.11 (a)). И создайте поверхность (surface), дважды щёлкнув по Thin => Surfaces, 

и, назвав её Gasket (Рисунок 2.11 (б)). 

 

Рисунок 2.11 (а) – Трехмерная модель прокладки 

 

Рисунок 2.11 (б) – Создание поверхности Gasket 

Построение болта 

Для создания детали нажмем кнопку Create Part . В появившемся окне 

Create Part дайте детали имя Bolt и примем следующие установки: 3D 

(трехмерное) Deformable (деформируемое)  Solid (твердое) тело с особенностью 

типа Revolution (вращение). В текстовом поле Approximate size наберите 3 

(Рисунок 2.12). Подтвердим заданные свойства нажатием кнопки Continue. 
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Рисунок 2.12 – Окно Create Part 

Нажимаем Continue и при помощи инструментов строим болт 

(Рисунок 2.13) нажимаем Done. 

 

Рисунок 2.13 – Эскиз болта 

В появившемся диалоговом окне Edit Feature в строке параметров Angle 

вводим угол поворота 360 градусов и нажимаем ОК (Рисунок 2.14) 
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Рисунок 2.14 – Часть болта после вращения 

Далее построим набросок профиля, который будет вытеснен по всей высоте 

головки болта, чтобы дать ему шестиугольную форму. Среди компонентов 

модулей выбираем Create Cut: Extrude . Выделяем поверхность головки 

болта, выбираем грань этой поверхности. 

Используя инструменты , и вспомогательную прямую  делаем эскиз 

шестиугольника. При помощи  создаем угол между вспомогательными 

прямыми равным 60 градусов (Рисунок 2.15), при этом радиус внешней 

окружности может быть выбран произвольно. 

 

Рисунок 2.15 – Наброски профиля 
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Нажимаем Done и  в появившемся диалоговом окне Edit Cut Extrusion 

выбираем Through All type. Стрелка в графической части должна быть направлена 

вниз, можно переключить её направление при помощи стрелки в диалоговом 

окне , затем нажимаем ОК (Рисунок 2.16) 

 

Рисунок 2.16 – Трехмерная модель болта 

Чтобы облегчить задание нагрузки болта в дальнейшем, создаем две 

базовые плоскости при помощи Tools→Datum в панели меню, как создавали для 

пластины, базовые плоскости должны быть определены на расстоянии 0,8 и  0,925 

от внешней поверхности головки болта (Рисунок 2.17).  

 

Рисунок 2.17 – Создание базовых поверхностей 

Теперь, чтобы создать сечение, выберите Tools→Partition из панели меню. 

Далее проделываем шаги, аналогично шагам по созданию сечений пластины 

(Рисунок 2.18) 
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Рисунок 2.18 – Создание сечений болта 

 Теперь следует разделить болт на 2 части – головку и стержень при 

помощи Tools→Partition, в появившемся окне Create Partition выбираем Cell и 

Define cutting plane. В графической части выделяем верхнюю часть болта и в 

панели инструкций выбираем по 3 точкам (3 Points) (Рисунок 2.19). 

 

 

Рисунок 2.19 – Создание сечений болта 

Далее в графической части выбираем 3 точки на гранях головки болта 

(Рисунок 2.20). 
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Рисунок 2.20 – Создание сечений болта 

Теперь следует разделить болт на 6 сечений при помощи Tools→Partition, в 

появившемся окне Create Partition выбираем Cell и Define cutting plane. В 

графической части выделяем весь болт и в панели инструкций выбираем по 3 

точкам (3 Points). Далее в графической части выбираем 3 точки на гранях головки 

болта (Рисунок 2.21). 

 

 

Рисунок 2.21 – Создание сечений на головке болта 

Повторяем данную операцию и с другими гранями болта (Рисунок 2.22). 
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Рисунок 2.22 – Модель болта 

Построение гайки 

Откроем в списке Module модуль PART. Для создания детали нажимаем 

кнопку Create Part . В появившемся окне Create Part дайте детали имя Nut и 

примем следующие установки: 3D (трехмерное) Deformable (деформируемое)  

Solid (твердое) тело с особенностью типа Extrusion (вытеснение). В текстовом 

поле Approximate size наберите 2 (Рисунок 2.23). Подтвердим заданные свойства 

нажатием кнопки Continue. 
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Рисунок 2.23 – Окно Create Part 

При помощи панели инструментов строим гайку (Размеры приведены на 

рисунке 2.24). 

 

Рисунок 2.24 – Эскиз гайки 

Нажимаем Done, в появившемся окне Edit Base Extrusion в строке Depth 

вводим значение 0.325 и нажимаем ОК (Рисунок 2.25). 
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Рисунок 2.25 – Трехмерная модель гайки 

Далее делим гайку на сечения при помощи Tools→Partition. В 

появившемся окне Create Partition выбираем Cell и Define cutting plane. 

Аналогично делению головки болта на сечения по 3 точкам (Рисунок 2.26). 

 

Рисунок 2.26 – Сечения гайки 

Модуль материала 

Далее задаем материал для каждой детали. Плита из латуни, гайка и болт из 

стали, а прокладка из резины. Открываем в списке Module модуль Property. 

Нажимаем Material Create , в появившемся окне Edit Material задаем 

наименование материала Brass. Далее в  строке меню материального редактора 

выбираем Mechanical→Elasticity→Elastic. Далее вводим модуль Юнга и 

коэффициент Пуассона в соответствующих областях (Рисунок 2.27).  
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Рисунок 2.27 – Материальный редактор – данные для латуни. 

В  строке меню материального редактора выбираем Mechanical→ 

Plasticity→ Plastic. И введем пластические свойства для латуни (Рисунок 2.28) И 

нажимаем ОК. 

  

Рисунок 2.28 – Материальный редактор – данные для латуни. 

Далее задаем свойства материала для стали и задаем наименование 

материала Steel. Далее в  строке меню материального редактора выбираем 

Mechanical→Elasticity→Elastic и вводим модуль Юнга и коэффициент Пуассона 

в соответствующих областях (Рисунок 2.29). 

 

Рисунок 2.29 – Материальный редактор – данные для стали. 

В строке меню материального редактора выбираем Mechanical→ 

Plasticity→ Plastic. Вводим пластические свойства для латуни (Рисунок 2.30). 

 

Рисунок 2.30 – Материальный редактор – данные для стали. 
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Задаем свойства материала для резины с наименованием Rubber. Далее в  

строке меню материального редактора выбираем Mechanical →Elasticity → 

Hyperelastic. Выбираем Mooney-Rivlin как энергетический потенциал напряжения 

и Coefficients как входной источник и вводим данные (Рисунок 2.31) 

 

Рисунок 2.31– Материальный редактор – данные для резины 

Теперь нужно определить и назначить секции. Секция пластины будет 

относиться к материалу латунь, секция прокладки будет относиться к резиновому 

материалу, а секция болта и гайки будет относиться к стальному материалу. В 

панели компонентов модулей выберите Create Section .В появившемся 

диалоговом окне Create Section называем сечение Plate Section, и выбираем Solid 

и Homogenous и нажмите Continue. В появившемся окне Edit Section выберите 

материал Brass и нажмите ОК. Аналогично выполняем и для других материалов. 

Дважды щелкните на Plate в дереве конструирования. На панели 

компонентов модулей выберите Assign Section , затем в графической части 

выделите всю плиту как область, которой назначат секцию и нажмите Done. В 

появившемся окне Edit Section Assignment выберите Plate Section и нажмите ОК 

(Рисунок 2.32) 

 

Рисунок 2.32 – Окно Edit Section Assignment 
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Те же самые действия выполняем и для других деталей. Для секции болта 

задайте наименование Bolt Section, для гайки Nut Section, а для прокладки Gasket 

Section.  

Сборка 

Перейдем к модулю Assembly и нажмите Create Instance , в 

появившемся окне Create Instance активируем строку Auto-offset from other 

instances, чтобы детали не накладывались друг на друга и выберем Plate. 

Нажмите ОК. В графической части появится пластина. Аналогичную операцию 

проведем для всех деталей, т.е. получаем 2 плиты, 1 прокладку, 2 болта и 2 гайки 

(Рисунок 2.33) 

 

Рисунок 2.33 – Окно Create Instance 

Используем команду Translate Instance  в панели инструментов. Далее в 

графической части выделяем всю прокладку и нажимаем Done. Перемещаем 

прокладку к плите, выбрав сначала точку на прокладке, а затем точку на пластине 

(Рисунок 2.34). Проделаем операцию с другой плитой, чтобы прокладка была 

между 2 плитами. 
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Рисунок 2.34 – Использование команды Translate Instance 

Чтобы выровнять болт с болтовым отверстием, используем Create 

Constraint: Parallel face  и удерживаем пока не появятся другие комплекты 

инструментов и выберите Create Constraint: Coaxial . Далее выбираем 

цилиндрическую поверхность болта (Рисунок 2.35)  

 

Рисунок 2.35 – Выбор поверхности болта 

Затем выбираем поверхность в отверстии плиты и нажимаем ОК (Рисунок 2.36). 
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Рисунок 2.36 – Выбор поверхности отверстия 

Чтобы одеть болт до конца используем команду Create Constraint: Parallel 

face  и удерживаем пока не появятся другие комплекты инструментов и 

выбираем Create Constraint: Face to face , затем выделяем поверхность на 

головке болта (для удобства возможно использование Remove Selected  чтобы 

скрыть части деталей) (Рисунок 2.37). 

 

Рисунок 2.37 – Выбор поверхности головки болта 

Затем выбираем плоскость на плите (Рисунок 2.38). Необходимо 

удостовериться, что стрелки направлены в одну сторону, при надобности, чтобы 

переключить направление стрелки используйте Flip в панели инструкций. 
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Рисунок 2.37 – Выбор плоскости на плите 

Затем нажимаем ОК, вводим значение 0,0 в панели инструкций. Далее так 

же надеваем болт во второе отверстие. Так же на болты надеваем гайки, используя 

инструменты Translate Instance и Create Constraint: Face to face  

(Рисунок 2.38). 

 

Рисунок 2.38 – Окончательная сборка 

Чтобы облегчить применение граничных условий позже в дереве 

конструирования раскрываем Assembly и дважды щелкаем на Sets в диалоговом 

окне называем основание набора Bottom и нажимаем Continue. 
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Определение процедуры анализа 

Далее создаем общий, статический шаг: Открываем модуль Step. Нажимаем 

команду Create Step . В появившемся диалоговом окне Create Step задаем 

наименование Bolt Load, выбираем тип General и Static, General и нажимаем 

Continue. 

Далее появляется диалоговое окно Edit Step включите On. В этом же 

диалоговом окне нажмите на вкладку Incrementation и изменяем начальный 

размер приращения на 0.25 ОК (Рисунок 2.39). 

 

Рисунок 2.3 – Окно Edit Step 

Контактные взаимодействия 

Затем, определяем свойства взаимодействия. В списке модуля выбираем 

Interaction. Затем на панели компонентов модулей выбираем Create Interaction 

Property . В появившемся окне Create Interaction Property назовем 

взаимодействие Friction1, выберем тип Contact и нажмем Continue. 

В появившемся диалоговом окне Edit Contact Property выбираем 

Mechanical→Tangential Behavior. В строке Friction formulation выбираем 

Penalty и вводим коэффициента трения 0.1 (Рисунок 2.40). 
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Рисунок 2.40 – Окно Edit Contact Property 

Далее выбираем Mechanical→Normal Behavior. В строке Constraint 

enforcement method выбираем Penalty (Standart) и нажимаем OK (Рисунок 2.41). 

 

Рисунок 2.41 – Окно Edit Contact Property 

Повторяем шаги, задав наименование взаимодействия Friction 2 с 

коэффициентом трения 0.4. В главной строке меню выбираем Create Interaction. 

В появившемся окне называем Contact, выбираем шаг Initial и General contact 

(Standard) и нажимаем Continue (Рисунок 2.42). 
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. 

Рисунок 2.42 – Окно Create Interaction 

В диалоговом окне Edit Interaction выбираем Friction1 как Global property 

assignment, затем нажимаем Individual property assignments  (Рисунок 2.43). 

 

Рисунок 2.43 – Окно Edit Interaction 

В диалоговом окне Edit Individual Contact Property Assignments выбираем 

(Global), как First Surface. Gasket как Second Surface и Friction-2 как Second 

Surface. Щелкните  и затем нажимаем OK (Рисунок 2.43). Нажимаем OK в 

диалоговом окне Edit Interaction. 
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Рисунок 2.43 – Окно Edit Individual Contact Property Assignments 

Теперь применяем ограничения, которые скрепляют болт и гайку. На 

панели компонентов модулей выбираем Find Contact Pairs . В появившемся 

диалоговом окне Find Contact Pairs в строке Include pairs within separation 

tolerance вводим значение 0.1, затем нажимаем на Find Contact Pairs (Рисунок 

2.44). 

 

Рисунок 2.44 – Окно Find Contact Pairs 
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Из списка контактных пар удаляем все пары, кроме Bolt-1-Nut-1 и Bolt-2-

Nut-2. В колонке Type изменяем содержание этих двух клеток от Interaction на 

Tie. Нажимаем OK (Рисунок 2.45) 

 

Рисунок 2.45 – Список контактных пар 

Нагрузки и граничные условия 

Применяем необходимые граничные условия для сборки. В списке модулей 

выбираем Load. В панели инструментов нажимаем команду Create Boundary 

Condition. В появившемся диалоговом окне Create Boundary Condition вводим 

наименование FixBase. Выбираем тип Initial, в котором будет активировано 

граничное условие. В списке Category принимаем Mechanical. В Types for Selected 

Step выбираем Symmetry/Antisymmetry/Encastre (Рисунок 2.46). Нажимаем 

Continue. 

 

Рисунок 2.46 – Окно Create Boundary 
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В панели инструкций нажимаем на Done и в графической области выделяем 

основание болта. В появившемся диалоговом окне Edit Boundary Condition 

включаем ENCASTRE, затем нажмите OK (Рисунок 2.47). 

 

Рисунок 2.47 – Окно Edit Boundary 

Применяем нагрузку к болту: В панели инструментов выбираем Create 

Load. Затем в диалоговом окне Create Load введем в поле наименования 

BoltLoad1. За шаг выбираем BoltLoad, в котором будет активирована данная 

нагрузка. В списке Category принимаем Mechanical. В Types for Selected Step  

выбираем Bolt load и Нажимаем Continue (Рисунок 2.48). 

 

 

Рисунок 2.48 – Окно Create Load 
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Далее нужно выбрать сечение болта как показано на рисунке 2.49 (для 

удобства используйте Remove Selected  чтобы скрыть детали и одно из 

сечений болта). Нажимаем на Surfaces в панели инструкций, затем выбираем 

любой цвет. 

 

Рисунок 2.49 – Выбор сечения для приложения внутренней нагрузки болта 

В графической области выбираем ось вдоль Bolt1 и в появившемся 

диалоговом окне Edit Load вводим величину 270 и нажимаем ОК (Рисунок 2.50). 

Повторяем процедуру для второго болта, назвав BoltLoad2, выберите Bolt2.  

 

Рисунок 2.50 – Окно Edit Load 
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Конечно-элементная модель 

В списке модулей выбираем Mesh. На панели состояния выбираем Part 

вместо Assembly и деталь Plate (Рисунок 2.51) 

 

Рисунок 2.51 – Панели состояния 

В панели компонентов модулей выбираем Seed Part   в появившемся 

диалоговом окне Global Seeds в строке approximate global size вводим значение 

равным 2 и нажимаем Apply и ОК (Рисунок 2.52). В панели компонентов модулей 

выбираем Mesh Part  и нажимаем Yes на панели инструкций. Аналогично 

строим конечно-элементную модель для Thin и Nut. 

  

Рисунок 2.52 – Конечная сетка элементов пластины 

Для построения конечно-элементной модели болта зайдите в меню Mesh => 

Controls, выберите всю деталь. Затем во вкладке Element Shape выберите Hex-

dominated и тип Sweep. Нажмите OK. С помощью инструмента Mesh Part  

завершите процесс построения сетки. 

Запуск на расчет 

Откроем в списке модулей Job. В панели компонентов модулей выбираем 

Job Manager .  В появившемся окне Job Manager нажимаем Create. В 

следующем диалоговом окне меняем наименование на BoltTightening  и 
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нажимаем Continue. В следующем появившемся окне Edit Job  нажимаем ОК. 

Далее в окне Edit Job  нажимаем Submit (Рисунок 2.53) 

 

Рисунок 2.53 – Статус работы в менеджере Job 

Анализ полученных результатов 

После окончания расчета нажимаем Results и автоматически переходим в 

модуль Visualization. Нажимаем на Plot Contours on Deformed Shape (Рисунок 

2.54 – 2.56). 

 

Рисунок 2.54 – Распределение напряжений на пластинах 

В результате максимальные напряжения на пластинах и на прокладке 

наблюдаются в отверстиях под болты. А максимальные напряжения на болтах 

наблюдаются вот втором сечении. 
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Рисунок 2.56 – Распределение напряжений на прокладке 

 

Рисунок 2.55 – Распределение напряжений на болтах 
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8. Моделирование напряженно-деформированного 

состояния стального диска 

Автор: Самигуллина Л.Г. 

Организация: НМСУ "Горный" 

В рамках данной задачи производится нахождение поля механических 

напряжений, возникающих при контактной деформации круглой стальной 

пластины. На рисунке 1.1 представлена принципиальная схема задачи. 

 

Рисунок 1.1 – Постановка задачи 

Перемещение инструмента составляет от 0.001 до 0.1 мм. 

Граничные условия: 

1. Пластина закреплена по контуру с возможностью угловых 

перемещений. 

2. Инструменту запрещены перемещения вдоль осей X и Y. 

Свойства материалов указаны в таблице 1.1. 
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Таблица 1.1 – Параметры материалов 

 
Модуль 

упругости, МПа 
Коэф. Пуассона 

Пластические свойства 

Напряжение, МПа 
Пластическая 

деформация 

Сталь Ст3 213 000  0.3 

200 0 

446.8 0.2 

503.8 0.4 

543.1669 0.6 

574.0994 0.8 

600 1 

622.4 1.2 

642.4 1.4 

660.6 1.6 

677.1 1.8 

692.5 2 

706.7 2.2 

720.1 2.4 

732.8 2.6 

744.8 2.8 

756.2 3 

Система координат модели и система единиц измерения 

Построение расчетной модели и обработка результатов производится в 

декартовой системе координат. При моделировании принята система измерений, 

представленная в таблице 2.1. 

Таблица 2.1 – Система единиц измерения 

Длина Давление Масса Время Температура Плотность 

𝑚𝑚 𝑀𝑃𝑎 𝑘𝑔 𝑠 ºC 𝑘𝑔\𝑚𝑚3 
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Геометрическая модель 

В дереве модели создадим 2 детали: Blank (диск) и Punch (инструмент). Для 

создания детали Blank установки следующие: Axisymmetric, Deformable, Shell. 

Осесимметричность используется в модели для возможности использования 

более плотной сетки и получения более достоверного решения. Для создания 

детали Punch используем установки: Axisymmetric, Discrete rigid, Wire. 

Инструмент моделируется как абсолютно жесткое тело, так как в рамках 

решаемой задачи распределение напряжений в инструменте нас не интересует. 

При помощи команды Tools=>Reference Point устанавливаем RP в центре 

окружности, как показано на рис. 2.1. 

 

а) 

 

б) 

Рисунок 2.1 – Построение эскиза: а) диск; б) инструмент 
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Модель материала 

Для выполнения задачи необходимо задать значения модуля упругости и 

коэффициента Пуассона, а также пластичные свойства материала пластины. 

Создадим материал с необходимыми свойством в дереве модели. В окне Edit 

Material зададим имя BlankSteel. В меню редактора выберем 

Mechanical=>Elasticity=>Elastic и введем значение E=213000 MPa, μ=0.3. Для 

введения возможности пластического деформирования материала заполним 

Mechanical=>Plasticity=>Plastic значениями, представленными в таблице 1.1. 

Теперь перейдём к определению сечения. Открываем диалоговое окно Create 

Section (вызов возможен либо из дерева модели, либо через иконку ). В 

диалоговом окне Create Section присвоим сечению диска имя BlankSection. 

Выберем в соответствующих списках Solid, Homogoneous и щелкнем Continue. В 

появившемся окне редактора сечений Edit Section, в качестве материала 

необходимо указать созданный ранее материал Blank Steel. 

Следующим шагом присвоим построенное сечение ранее созданной детали. 

Для этого используем иконку  Assign Section в текущей панели инструментов 

(либо дважды щелкаем по элементу в дереве модели, либо используем команды 

меню: Assign=>Section). 

Сборка 

Перейдём к модулю Assembly. Для создания сборочной единицы необходимо 

нажать на иконку Create Part Instance  (либо в дереве модели дважды кликнуть 

по элементу , либо воспользоваться командами: меню Instance=>Create). 

Появится окно со списком созданных деталей Parts. Выберем обе детали, 

поставив галочку напротив пункта «Аuto-offset from other instances». 

Для того чтобы переместить инструмент в правильное положение по 

отношению к диску, необходимо применить операцию Translate Instance (иконка 

 в модуле Assembly). В ней необходимо выбрать сферическую часть 
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инструмента в качестве передвигаемой области, а затем последовательно указать 

нижнюю точку сферической части инструмента и угол диска. 

Итоговая модель сборки представлена на рисунке 2.2. 

 

Рисунок 2.2 – Создание экземпляра сборки 

Определение процедуры анализа 

В контейнере Step создадим новый шаг анализа – Analysis типа Static, 

General. В появившемся окне Edit Step, включим функцию нелинейной 

геометрии: Nlgeom=>On, все остальные настройки решателя остаются без 

изменений. 

Контактные взаимодействия 

Зададим контактное взаимодействие пластины и инструмента. Для этого в 

окне Create Interaction (модуль Interaction) выберем тип Surface-to-Surface. В 

качестве главной поверхности выберем сферическую поверхность инструмента, а 

в качестве подчиненной – верхнюю поверхность диска. 
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Рисунок 2.3 – Создание контактного взаимодействия 

После этого необходимо создать свойства контакта Interaction Property типа 

Contact. В появившемся окне Edit Interaction Property необходимо задать 

следующие свойства: Mechanical=>Tangential Behavior=>Penalty и Friction 

Coeff=>0.2. 
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Рисунок 2.4 – Определение свойств контактного взаимодействия 

Нагрузки и граничные условия 

В модуле Load необходимо задать граничные условия, действующие на 

модель. В окне Create Boundary Condition создадим следующие граничные 

условия: 

1. «BlankFix» типа Displacement, Rotation, задающее отсутствие перемещений 

боковой грани диска на шаге анализа Analysis. Необходимо выбрать область, 

указанную на рис. 2.5, далее указать U1=0, U2=0, UR3=0. 
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Рисунок 2.5 – Иллюстрация к созданию граничного условия «BlankFix» 

2. «PunchDispl» типа Displacement, Rotation, задающий перемещение на шаге 

анализа Analysis. Необходимо выбрать область, указанную на рис. 2.6 (RP детали 

Punch), далее указать U1=0, U2=-1, UR3=0. 

 

Рисунок 2.6 – Иллюстрация к созданию граничного условия «PunchDispl» 
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Конечно-элементная модель 

Следующим шагом было создание конечно-элементной сетки деталей в модуле 

Mesh. В рамках студенческой версии программного продукта, учитывая 

ограничение в 1000 элементов, для детали Blank была предложена сетка, 

состоящая из 855 элементов. 

Для создания сетки используем операцию Seed=>Edges и выбрав боковые 

грани диска, устанавливаем значения, как это показано на рис. 2.7. Для верхней и 

нижней граней значения представлены на рис. 2.8. 

 

 

Рисунок 2.7 – Установка узлов сетки на боковых гранях диска 

 

 

Рисунок 2.8 – Установка узлов сетки на верхней и нижней гранях диска 
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Используя операцию Mesh=>Part получим конечно-элементную модель, 

представленную на рисунке 2.9. 

 

 

Рисунок 2.9 – Создание конечно-элементной модели детали Blank 

Для создания сетки элемента Punch используем операцию Seed=>Edges и 

устанавливаем значения, как это показано на рис. 2.10. 

 

 

Рисунок 2.10 – Установка узлов сетки детали Punch 

Для создания сетки используем, как и в случае с диском, Mesh=>Part. 

Запуск на расчет 

Перейдем в модуль Job. С помощью иконки Create Job (либо команд меню 

Job=>Create, или дважды кликнув по элементу в дереве модели) создадим 

задание на расчёт. В появившемся окне Create Job, присвоим заданию имя 

Contact. 

Задание на расчёт сформировано. Запустим расчет, вызвав  

JobManager=>Submit. Надпись Running говорит о том, что расчет запустился. 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 

 

160 

Анализ полученных результатов 

На рисунке 3.1 и 3.2 представлены распределения полей механических 

напряжений и перемещений модели.  

 

Рисунок 3.1 – Распределение поля напряжений по Мизесу 

 

Рисунок 3.2 – Распределение поля пластических деформаций 

Для визуализации напряжений и деформаций в развертке можно 

использовать команду ODB Display Options ( )=>Sweep/Extrude, далее 

заполнить поля, как показано на рис. 3.3. 
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Рисунок 3.3 – Создание развертки в модуле Visualization 

При значении угла поворота в 180°, получим распределение как на рис. 3.4. 

 

Рисунок 3.4 – Распределение поля напряжений по Мизесу в развертке 

Если в созданной модели не вводить возможность пластического 

деформирования материала (пропустить пункт Mechanical=>Plasticity=>Plastic в 

окне Edit Material п. 2.3), напряжения в диске будут значительно больше несущей 

способности, что не соответствует действительности. 
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Рисунок 3.5 – Распределение поля напряжений по Мизесу в упругой модели 

Таким образом, при моделировании напряженно-деформированного 

состояния (НДС) необходимо учитывать как упругие, так и пластические свойства 

задаваемых материалов. Это позволяет получить картину, соответствующую 

реальным распределениям напряжения. 

Созданная модель позволяет оценивать НДС в условиях контактного 

взаимодействия. 


